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ETAS はじめに
1 はじめに

本章には以下の情報が含まれています。

• 安全に関する注意事項の記述書式（7 ページ）

• 情報の表現について（7 ページ）

• 製品パッケージの内容（8 ページ）

• その他の情報（8 ページ）

1.1 安全に関する注意事項の記述書式

本書内に記述されている安全に関する注意事項には、下記の標準シンボルが併記さ
れます。

安全に関する注意事項は以下の書式で記述されます。これらの情報は必ずよくお読
みください。 

1.2 情報の表現について

ユーザーが実行する操作についての説明は、いわゆる "Use-Case" 形式で記述され
ています。つまり、以下に示すように、操作によって実現させる目標がタイトルと
して簡潔に記述され、その下に、その目標を実現するために必要な手順が列挙され
ます。また必要に応じてアプリケーションウィンドウやダイアログボックスのスク
リーンショットが添付されます。

操作の目標：

前置き ...

• 手順 1

手順 1 についての説明 ...

• 手順 2

手順 2 についての説明 ...

• 手順 3

手順 3 についての説明 ...

まとめ ...

危険！

高度の危険性に関する注意事項です。記載事項を守らないと、死亡、ま
たは重篤な傷害を招く可能性があります。

警告！

中程度の危険性に関する注意事項です。記載事項を守らないと、重傷や
生命の危険を招く可能性があります。

注意！

軽度の危険性に関する注意事項です。記載事項を守らないと、軽～中程
度の負傷を招く可能性があります。
7ES720.1 - ユーザーズガイド
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はじめに ETAS
表記上の規則

本書は以下の規則に従って表記されています。

特に重要な注意事項は、以下のように表記されています。

また PDF 文書において、索引、および他の部分を参照する個所（例：「xxxxx」を参
照してください」の「xxxxx」の部分）については、その参照先へのリンクが設けら
れているので、必要な参照個所を素早く見つけることができます。

1.3 製品パッケージの内容

本製品を最初に使用する際は、前もって製品パッケージにすべてのアイテムが含ま
れていることを確認してください（153 ページの 11.1 項を参照してください）。

追加のケーブルやアダプタは、ETAS から別途ご購入いただけます。ご購入できるア
クセサリの一覧とオーダー情報は、本書の 78 ページの「アクセサリ」、および ETAS
製品カタログに掲載されています。

1.4 その他の情報

本製品を INCA と共に使用する際の設定方法については、ソフトウェアのユーザー
ドキュメントを参照してください。

表記例 説明

File → Open を選択して、... ユーザーインターフェースのメニューコマン
ドは、青の太字で表記します。

OK をクリックして、... ユーザーインターフェース上のボタン名は、
青の太字で表記します。

<Ctrl> を押して、... キーボードの各キーは、< > で囲んで表記し
ます。

"Open File" ダイアログボックス
が表示されます。

プログラムウィンドウ、ダイアログボック
ス、入力フィールド等のタイトルは、" " で
囲んで表記します。

ON/AUTO スイッチ モジュール筐体に印字されたラベルは黒の太
字 で表記します。

「キーワード」 重要な用語（特に初出のもの）は「」で囲ん
で標記します。

注記

ユーザー向けの重要な注意事項
ES720.1 - ユーザーズガイド



ETAS 安全に関する基本事項
2 安全に関する基本事項

本章には以下の情報が含まれています。

• 安全に関する一般情報（9 ページ）

• ユーザー要件と使用者の義務（9 ページ）

• 適切な使用法（9 ページ）

2.1 安全に関する一般情報

本製品を使用する際には、ユーザーの健康への影響や装置の損傷などを避けるため、
安全に関する注意事項（「ETAS Safety Advice - 安全上のご注意」）、および下記の注
意事項をよくお読みいただき、その指示に従ってください。

製品の不適切な取扱いや、所定の範囲外での使用、または安全に関する注意事項の
不順守により生じた一切の損害について、ETAS GmbH は責任を負いません。

2.2 ユーザー要件と使用者の義務

本製品の設置、操作、メンテナンスは、必ず所定の資格と経験を有する方のみが
行ってください。不適切な使用や、所定の資格を有していないユーザーによる使用
は、人体への健康被害や器物の損壊を招く恐れがあります。

作業時の安全に関する一般的な注意事項

作業安全および事故防止に関する法令を遵守してください。本製品を使用する際は、
その操作に対して適用されるすべての規則や法令に従う必要があります。

2.3 適切な使用法

本製品の使用範囲

自動車産業用途向けに開発され、発売されたものです。室内、または車両の客室ま
たはトランクルーム内での使用に適しています。エンジンルームやそれに類する環
境での使用には適していません。異なる用途でのご使用については、ETAS のお問い
合わせ窓口までご相談ください。

本製品は、気温 55 °C ～ 70 °C の、以下の条件を満たす操作用設備内においてのみ
使用できます。

1. 操作用設備へのアクセスが以下の者に制限されていること

－ メンテナンス作業を行う者

－ 操作用設備へのアクセス制限と遵守すべき安全対策を認識しているユー
ザー

2. 操作設備のセキュリティが以下のように確保されていること

－ 操作設備へのアクセスが、錠や鍵なとにより制限され、設備の責任者によ
り監視されていること

注記

製品を使用する際には、前もって、製品に添付された各ドキュメント（安全に関す
る注意事項とユーザーズガイド）をよくお読みください。
9ES720.1 - ユーザーズガイド
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安全に関する基本事項 ETAS
本製品の使用環境に関する要件

本製品は最新のテクノロジーと一般的な安全規則に基づき設計されています。本製
品は、技術的不備のない状態において、規定された範囲内の目的のためにのみ操作
することができ、その際には製品の付属文書に記載された安全性と危険性について
理解していなければなりません。それらの条件を守らずに製品を使用すると、本製
品の保護機能が損なわれる恐れがあります。

操作時の要件

• 本製品は、必ず製品のユーザーズガイド（本書）に記載されている仕様に
従って使用してください。仕様に従わずに使用した場合、本製品の安全性は
保証されません。

• 環境条件に関する要件を守ってください。

• 本製品は、水に濡れた場所や湿気のある環境では使用しないでください。

• 本製品は、爆発の危険性のある雰囲気内では使用しないでください。

ES720.1 と ETK の併用 

ES720.1 と ETK のハードウェア構成を変更したり、ES720.1 のソフトウェアを更新
したりすると、ECU のリセットが発生する可能性があります。

WLAN の機能

電気保安と電源

• 使用場所に適用される電気安全に関する法令と、作業安全に関する法律と法
令に従ってください。

注意！

モジュール表面の高温による熱傷の危険性があります！
高気温における操作時には、モジュール表面に触れることは避けてくだ
さい。
車両内、または 70 °C の外気温においては、モジュールの表面温度が

90 °C に達する場合があります。

警告！

ECU の不適切なリセットにより、エンジンがシャットダウンする可能性
があります！ 
ETK を接続した ES720.1 を操作する場合、 ETK 用の新しい実験を

ES720.1 にダウンロードする際は、必ず車両を停止した状態で行ってく
ださい。
またその際には、ES720.1 の MEAS LED が点灯状態（点滅ではなく、連
続的に ON になる状態）になるまで、車両の運転は行わないでください。

注記

ドライブレコーダ ES720.1-8W および ES720.1-16W は、EU（欧州連合）、米国、
カナダ、インドでのみ認証されています。

注記

ドライブレコーダ ES720.1-8W および ES720.1-16W の WLAN 機能は、屋内使用
向けに設計されています。
ES720.1 - ユーザーズガイド



ETAS 安全に関する基本事項
• 本製品のコネクタ部に接続できるのは、EN 61140（保護等級 III）に準ずる安
全特別低電圧の電気回路に限られます。

• 所定の接続方法と設定値（第 8 章 「テクニカルデータ」を参照）を遵守して
ください。

• 本製品のコネクタ部に規定された範囲外の電圧をかけないでください。

電源

• 本製品の電源は、商用電源や家庭用電源から確実に分離されていなければな
りません。車両バッテリまたは実験用の適切な専用電源を使用してください。

• 実験用の専用電源は、電源ネットワークに対する 2 重保護対策が施されたも
の（2 重絶縁 / 強化絶縁（DI/ RI））のみを使用してください。

• 実験用の専用電源は、高度 5000 m、周囲温度 70 °C までの使用に対して承
認されたものである必要があります。

• 本製品の通常運転や非常に長いスタンバイ運転を行うと、車両バッテリーが
放電して空になってしまう可能性があります。

電源への接続

• 電源ケーブルを自動車用バッテリまたは実験用の専用電源に接続する際には、
直接接続してはいけません。必ずヒューズ（最大 20 A）を介して接続してく
ださい。

• 実験用の専用電源、本製品、車両バッテリの各電源接続部には、容易に手が
届く状態を確保してください。

• 電源ケーブルは、擦れ、損傷、変形、折れが生じないように配線してくださ
い。電源ケーブルの上に物を置かないでください。

電源供給の切断

本製品には電源スイッチがありません。以下のいずれかの方法で本製品を非通電状
態にすることができます。

• 電源ケーブルの電源供給側（実験室側または車両バッテリ側）のプラグを取
り外す

• 電源ケーブルの本製品側のプラグを取り外す

• 車両バッテリーを使用している場合は、バッテリー端子の接続を取り外す

ケーブル仕様

• 本製品の接続部には必ず ETAS ケーブルを使用してください。

• ケーブルの最大許容長を遵守してください。

• 損傷したケーブルは使用しないでください。ケーブルの修理は必ず ETAS に
依頼してください。

危険！

危険な高電圧が印加されます！
電源ケーブルは、適切な車両バッテリまたは実験用の適切な専用電源に
のみ接続してください！商用電源ソケットには絶対に接続しないでくだ
さい！
誤って商用電源ソケットに接続してしまうのを防止するため、商用電源
ソケットの近辺では安全バナナプラグ付き電源ケーブルのご使用をお勧
めします。
11ES720.1 - ユーザーズガイド
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安全に関する基本事項 ETAS
• コネクタは決して無理な力でソケットに押し込まないでください。ソケット
の内部と外部に汚れがないこと、コネクタとソケットの形状が互いに合って
いること、さらにコネクタがソケットに正しく差し込まれていることを確認
してください。

設置場所に関する要件

• 本製品の単体モジュールまたはモジュールスタック（複数モジュールを縦に
組み付けたもの）は、表面が滑らかで平坦な、しっかりした土台の上に設置
してください。

• 本製品の単体モジュールまたはモジュールスタックは、常に確実に固定され
ている必要があります。

キャリアラックへの固定

• 本製品を取り付けるキャリアラックを選択する際には、本製品の単体モ
ジュールまたはモジュールスタックによりキャリアラックに対して発生する
静的および動的な力に注意してください。

換気に関する要件

• 本製品は熱源から遠ざけ、直射日光を避けてください。

• 本製品の上方および後方には、十分な空気対流が確保されるスペースを確保
してください。

複数モジュールの接合と分離

• 本製品をモジュールスタックとして使用する場合、その組み付けまたは取り
外しを行う際には、前もってモジュールを電源から切り離しておくか、動作
状態を「スタンバイ」にしておく必要があります。

搬送

• 本製品の組み付けやケーブル接続は、本製品を実際に使用する場所に搬送し
てから行ってください。

• 本製品の搬送は、必ずモジュール本体を持って行ってください。ケーブルを
つかんで搬送しないでください。

メンテナンス

本製品はメンテナンス不要です。

修理

ETAS のハードウェア製品の修理が必要となった際には、その製品を ETAS へお送り
ください。

モジュールハウジングの清掃

• 本製品のモジュール筐体の清掃には、糸くずの出ない布を、乾いた状態、ま
たは軽く湿らせた状態で使用してください。

• モジュール筐体を損傷する危険のあるスプレー、溶剤、研磨剤などは使用し
ないでください。

• モジュール筐体に水分が浸入しないようにしてください。モジュール筐体へ
洗剤の噴霧は、絶対に行わないでください。

環境条件

本製品のモジュール筐体とケーブル接続用ソケット、およびケーブルのプラグの保
護等級は IP20 です。
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環境条件についての詳細は、59 ページの 8.2 項を参照してください。

モジュール筐体の分解

等電位化

ケーブル接続

ケーブルの接続については 35 ページの 5.2 項を参照してください。

注意！

モジュールの損傷や IP20 特性の損失が発生する可能性があります！
モジュール筐体を分解したり改造したりしないでください。
モジュール筐体に対する作業は、必ず ETAS が行うものとします。

注意！

モジュールの接続ケーブルのシールドを通して、予期しない電流が発生
する可能性があります！
モジュールは必ず等電位の場所に設置するか、またはモジュールをその
設置場所から絶縁してください。
13ES720.1 - ユーザーズガイド
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ハードウェア ETAS
3 ハードウェア

本章では、ES720.1 の概要を紹介し、製品のバリエーション、筺体、接続および

LED などについて説明します。

3.1 概要

汎用性の高いドライブレコーダ ES720.1 は、自動車の電子制御システムの各工程
（開発、適合、検証など）で行われるさまざまな測定／記録作業に使用できます。

ES720.1 は、Windows XP Embedded オペレーティングシステムを搭載した「エン
ベデッド PC」をベースとしており、記録内容のセットアップを行うこともできま
す。設定後は、接続されているハードウェアのデータを自動的に記録します。

図 3-1 ES720.1 ドライブレコーダ

ES720.1 モジュールには 1 つのイーサネットポートと 4 つの USB ポートが装備さ
れ、イーサネットインターフェースまたは USB インターフェースを用いて ETAS モ
ジュールの測定環境に統合できます。

ECU と ETAS バスインターフェースモジュール（ES59x シリーズ）、および ETAS 測
定モジュール（ES4xx ／ ES63x 製品ファミリ）は、イーサネットにより相互にネッ
トワーク接続でき、ドライブレコーダにも接続できます。XETK（XCP-on-Ethernet
インターフェース）を取り付けた ECU をこのドライブレコーダに直接接続すること
もでき（一基のみ）、ES581 モジュールを使用して車両ネットワークの CAN バスを

ES720.1 の USB ポートに接続することもできます。

また、このモジュールにはデジタル TTL 対応の入力と出力が 4 点ずつ装備されていま
す。

ドライブレコーダ ES720.1 は INCA との互換性があります。INCA は ECU の測定、
適合、診断を行うための標準ツールで、測定信号の選択、データ収集レートの設定、
記録開始／終了トリガや通信、診断プロトコルの設定などは、INCA から直接行いま
す。
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3.1.1 製品のバリエーション

ES720.1 ドライブレコーダ（本体）には、以下のようなタイプがあります。

• ドライブレコーダ（WLAN モジュールなし）

－ ES720.1-8（内部メモリ 8GB）

－ ES720.1-16（内部メモリ 16GB）

• ドライブレコーダ（WLAN モジュール搭載）

－ ES720.1-8W（内部メモリ 8GB）

－ ES720.1-16W（内部メモリ 16GB）

ES720.1 ドライブレコーダの製品パッケージには、上記の各タイプごとに付属の電
源ケーブルのタイプが異なる 2 種類のバリエーションが用意されています。詳しく
は 10.1 項「ES720.1 の製品バリエーション」を参照してください。

3.1.2 製品の特性

ES720.1 の主な特性や機能を以下にまとめます。

• Windows XP Embedded オペレーティングシステム搭載の PC をベースとす
るモジュール

• 標準 PC ポート（USB、イーサネット、VGA）

• 外部拡張用の 4 つの独立型 USB ポートに以下のようなデバイスを接続可能

－ フラッシュメモリ（標準 USB スティック）

－ キーボード

－ マウス

－ GPS レシーバ

• 入力／出力機能（デジタル入力 ×4ch、デジタル出力 ×4ch）

• WLAN（オプション）

• ECU、バスインターフェース、測定モジュールなどを接続して測定システム
を構築可能

• 接続されているすべてのモジュールとその測定チャンネルを正確に同期化

• 記録開始までの遅延を最小化（ES593-D モジュールとの連携による高速ブー
トアップ）

• 電源管理のためのオプション機能（ウェイクアップ、スタンバイ）

• 自動スタンバイ機能

• ODX による診断データの扱い

• 複数の実験を指定の順序で実行

• さまざまな自動車アプリケーションに適した筺体により、開発環境での使用
や試運転時の車載用に好適

－ 外部環境（温度、EMC）の影響を受けにくい

－ 広い電源電圧範囲

－ 高い機械的安定性とロバスト性

• ETAS ツールスイートの一環

注記

ドライブレコーダ ES720.1-8W、ES720.1-8W、ES720.1-16W、ES720.1-16W
は、EU（欧州連合）、米国、カナダ、インドでのみ認証されています。
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ハードウェア ETAS
ES720.1 の詳細なテクニカルデータは、54 ページの「テクニカルデータ」という章
に記載されています。

3.2 筺体

3.2.1 特性

ES720.1 には前面と背面に接続ポートを備えた筺体が使用されています。筺体は頑
強な金属製で、滑り止め加工が施されたプラスチック脚が付いています。

モジュールを車両や実験室に設置する際は、キャリアユニットなどにボルトで容易
に固定することができます。また、同タイプの筺体が使用されたモジュール

（ES59x、ES63x、ES910）を連結することもできます（32 ページの 5.1 項を参照し
てください）。

ES720.1 モジュールは、実験室やテストベンチ、自動車の客車内などに設置して使
用することを前提に設計されています。

3.2.2 イーサネットアダプタの MAC アドレス

ES720.1 に組み込まれているイーサネットアダプタの MAC アドレスは、モジュー
ルの底面パネルに記載されています。このアドレスはソフトウェアのライセンス管
理に必要なものです。

3.2.3 WLAN アダプタの MAC アドレス（WLAN モジュール搭載ドライブレコー

ダの場合）

WLAN モジュールを搭載したタイプの ES720.1 の場合、WLAN アダプタの MAC ア
ドレスがモジュールの底面パネルに記載されています。
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3.3 接続

3.3.1 前面パネル

ES720.1 の前面パネルには以下のポートが配置されています。

• ETH（イーサネット、SYNC-OUT）

• （USB ポート ×4）

USB ポートの右にある電源ボタンで、ドライブレコーダの電源オン／オフを切り替
えます。

図 3-2 前面パネル

3.3.2 背面パネル

ES720.1 の背面パネルには以下のポートが配置されています。

• 7-29V（動作電圧）

• I/O（デジタル入力／出力）

• VGA（アナログインターフェース搭載モニタ接続用 VGA ポート）

• ANT（WLAN アンテナ）

図 3-3 背面パネル
17ES720.1 - ユーザーズガイド
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3.4 LED

3.4.1 点滅パターン

ES720.1 には、モジュールの動作ステートや信号接続状態、測定／記録状態などを
示す 6 個の LED が設置されています。各 LED には、さまざまな情報を表現するため
の点滅パターンが定義されていて、点滅時の点灯時間が以下のように異なります。

3.4.2 モジュールの状態

前面パネルの以下の 3 つの LED は、モジュールの状態を示します（17 ページの図

3-2 を参照してください）。

• ON： 電力供給状態と動作ステート

• ETH： ETH ポートの機能状態

• WLAN： WLAN ポートの機能状態

ES720.1 の稼動時（動作ステート： オン）において、2 つの通信ポートの機能状態
が、それぞれ対応する LED（ETH および WLAN）で示されます。WLAN は WLAN
モジュールを搭載したタイプでのみ機能します。

点滅パターン 点灯時間 消灯時間

点滅 1 500ms 500ms

点滅 2 100ms 1900ms

LED の名称
（色）

LED の状態 モジュールの状態

ON
（緑）

ON（点灯） - 電力供給あり

- モジュールの動作ステート： ON

点滅 1 モジュールは以下のいずれかの状態

- 起動処理中

- シャットダウン処理中

- スタンバイ状態または OFF 状態に移行中

点滅 2 - モジュールの動作ステート： スタンバイ（消費電流が
最小化された状態）

- ON 状態にするにはウェイクアップイベントが必要

OFF（消灯） - 電力供給なし

ETH
（黄）

OFF - イーサネット接続なし

ON - イーサネット接続確立済み

点滅 1 - ETH インターフェースで通信中

WLAN
（黄）

OFF - WLAN 接続なし

ON - WLAN 接続確立済み

点滅 1 - WLAN インターフェースで通信中
ES720.1 - ユーザーズガイド



ETAS ハードウェア
3.4.3 モジュールのエラー状態と測定／記録状態

モジュールのエラー状態と測定／記録状態は、前面パネルの以下の 3 つの LED と前
出の ON LED によって示されます（17 ページの図 3-2 を参照してください）。

• MEAS： 測定／記録状態

• ER： モジュールのエラー状態

• MEM： メモリ状態とメモリアクセス

下の表のように、複数の LED の組み合わせによって 1 つの状態が示されます。背景
が灰色のフィールドは、その LED が当該状態の表示には使用されないことを示して
います。

3.4.4 その他の接続状態

USB、I/O、VGA ポートの状態は、LED 表示されません。

ON
（緑）

MEAS
（橙）

MEM
（橙）

ER
（赤）

エラー状態と測定／記録状態

ON
（点灯）

ES720.1 が起動していますが、有
効なライセンスがインストールさ
れていません。

点滅 1 点滅 1 点滅 1 点滅 停電復帰状態。ES720.1 のコン
フィギュレーションファイルおよ
び前回の記録ジョブのデータが損
傷している可能性があります。

OFF
（消灯）

メモリ容量（内部記憶と CF カー
ド）が十分な状態

ON ON メモリ容量（内部記憶と CF カー
ド）が不十分な状態

ON OFF メモリ容量のワーニングしきい値
（ES720 コンフィギュレーション
ツールで調整可能）に到達しまし
た。まもなくメモリの空き領域が
なくなります。

ON 点滅 接続されているハードウェアが初
期化されていません。

OFF 測定を行っていない状態

ON 測定とデータ記録の実行中

点滅 1 測定準備が完了し、トリガイベン
トを待っている状態

ON 点滅 1 測定したデータを USB 接続された
メモリに書き込んでいる状態

OFF 点滅 1 測定値以外のデータを USB メモリ
に書き込んでいる状態（ファイル
転送などを実行中）
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3.5 通知音

ES720.1 はアコースティック信号ジェネレータを搭載しており、ES720 コンフィ
ギュレーションツール（コンフィギュレーション設定用ソフトウェアツール）通知
音（ビープ音）のオン／オフを切り替えることができます。

3.6 電源ボタン

前面パネルの電源ボタンを押すと、ES720.1 の動作ステート（ON ／ OFF）が切り替
わります。

I/O ポートにリモートスイッチを接続することにより、電源ボタンの機能をリモート
操作することができます（28 ページの 4.9.3 項を参照してください）。

通知音の数 通知音の持続時間 [s] アクション／機能状態

1 0.5 電源ボタン押下

2 0.5 記録準備完了

3 0.5 記録終了

1 2 エラー
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4 機能説明

本章では、ES720.1 モジュールのブロックダイアグラムを紹介し、電力供給、イン
ターフェース、動作ステートとその変化、データ転送、内部監視などについて説明
します。

4.1 ブロックダイアグラム

図 4-1 ブロックダイアグラム

4.2 電力供給（“7-29V” ポート）

ES720.1 の電力供給ポート（7-29V）は背面パネルに配置されています。ここに 2
極プラグコネクタ（Lemo ソケット）を差し込み、外部電源または自動車のバッテリ
電源から電流を供給します。

ご購入後の ES720.1 に初めて電源を投入すると、数秒間電源がオンになり、

ES720.1 の初期化と設定が行われます。その後、ES720.1 は短い通知音を発し、低
電力スタンバイ状態で待機します。

4.3 イーサネットインターフェース（“ETH” ポート）

ETH ポートは、測定対象の ES63x モジュール、測定／適合／ラピッドプロトタイピ
ングモジュール、またはホスト PC をイーサネット接続するためのものです。

注記

ES720.1 は、電流を消費しないように、すべての供給電圧と物理的に分離してお
く必要があります。

7 - 29V

ETH
10/100 MBit

CFカード
8 GB

エンベデッドPC
PCI CoreExpress - ECO

Intel Atom 1.6 GHz
1 GB RAM

電源

前面パネルの

LED（×6）

前面パネルの押ボタン

リアルタイム

クロック

USB

USB

USB

USB

アンテナ WLAN

スタンバイおよび

デジタルI/O 
マイクロコントローラ

VGA

イーサネット
トラフィック

検知

イーサネット
トランシーバ

10/100

イーサネット

物理層

I/O （26ピン D-SUB）

温度センサ

ビープ

バッテリ
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このイーサネットインターフェースは 10/100BaseT 規格に適合していて、10Mbps
または 100Mbps の半二重モードまたは全二重モードで使用できます。スイッチン
グは自動で行われます。

接続されているモジュールからのデータ収集のタイミングは、実際の測定タイミン
グとは同期しません。

ETH インターフェースは ES720.1 の他のインターフェースや電源から電気的に絶縁
されています。

イーサネットインターフェースの機能

• ホスト PC への接続

• コンフィギュレーションのダウンロード

• 測定されたデータのアップロード

• 接続されている測定モジュールやインターフェースモジュールへのアクセス

• ウェイクアップ機能のサポート（27 ページの 4.9 項を参照してください。）

• ドライブレコーダのファームウェアとコンフィギュレーションソフトウェア
の更新

4.4 USB インターフェース（“USB” ポート）

ES720.1 には 4 つの独立した USB ポートがあり、外部デバイスを接続してモジュー
ルの機能を拡張することができます。

このポートでサポートされているのは、Windows XP Embedded 対応のソフトウェ
アとドライバを搭載しているデバイスのみです。この条件を満たすデバイスを接続
すると、専用ドライバをインストールしなくてもすぐにそのデバイスの基本機能が
使用可能になります。ただしメーカー固有の拡張機能や専用ドライバは、ユーザー
が個別にソフトウェアをインストールする必要があります。

このポートには、キーボード、マウス、記憶媒体（USB スティック、ハードディス
ク）などを接続できます。

4.4.1 外部拡張機能

メモリ拡張

USB メモリは必ず FAT32 ファイルシステムにフォーマットしてください。複数パー
ティションへの分割はサポートされていません。

プリインストールされているソフトウェアをアンインストールするには、必ず USB
メモリ製造元が提供する専用アンインストーラソフトウェアの最新版を使用してく
ださい。このソフトウェアは、インターネット上の USB メモリメーカーのサイトか
らダウンロードできます。 

注記

外部モジュールの電源供給は ES720.1 では制御できません。

注記

USB メモリにプリインストールされているソフトウェアやデータは、ES720.1 に
使用する前にアンインストールまたは削除しておく必要があります。

注意！

データ損失の恐れがあります！
データ転送中に USB メモリを ES720.1 から引き抜かないでください。
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その他の注意事項、および ES720.1 のメモリ拡張用に ETAS が推奨する USB メモリ
の一覧は、67 ページの 8.5.8 項に記載されています。

GPRS

ES720.1 の USB ポートに GPS レシーバを接続して使用することができます。

ECU バスへのアクセス

USB モジュールである ES581 CAN バスインターフェースを接続することにより、

CAN バスにアクセスすることができます。ただし併用する INCA のバージョンに
よっては、ES581 を使用するために INCA アドオンをインストールする必要があり
ます。

4.4.2 最大出力電流

ES720.1 の 4 つの USB ポートは、それぞれ USB 規格に従い最大 500mA の出力電流
を提供できます。

ただし 4 つのポートの出力電流の合計の最大値は、1 つの USB ポートの最大出力電
流の 4 倍より小さくなります。

注記の条件を満たすためには、4 つの USB 出力段の負荷を外部回路により分散させ
る必要があります（例： 2×500mA と 2×100mA）。

4.4.3 過負荷と緊急停止

いずれかの USB ポートの出力段が短絡により過負荷状態になった場合や、4 つの

USB ポートの出力電流合計が 1.2A を超えた場合、ES720.1 は以下の処理を順に自動
実行します。

1. すべての USB ポートの電源をオフにします。

2. 実験を中断します。

3. 測定されたデータを内部メモリに保存します。

4. ES720.1 を緊急停止させてハードウェアを保護します。

5. エラー状態を表示します。

注記

4 つの USB ポートの出力電流の合計が 1.2A を超えることはできません。

注記

測定データ保存用の外部記憶媒体が NTFS にフォーマットされている場合、その
ファイルシステムと保存されている測定データは、ES720.1 緊急停止時に損傷し
たり消去されたりする可能性があります。
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4.5 I/O インターフェース（“I/O” ポート）

4.5.1 概要と機能

I/O ポートには 26 ピンの HD D-Sub ソケットが使用され、さまざまなデジタル入力
と出力の機能が割り当てられています。

ES720.1 はデジタル入力信号の記録とデジタル出力信号の制御を行うことができま
す。入力と出力は過電圧から保護されています。

4.5.2 使用例

デジタル入力

デジタル入力は以下のような用途に利用できます。

• ECU のイグニション端子（Tl. 15、イグニッションオン）との連動

－ Tl. 15 の立ち上がりエッジでモジュールを起動

－ Tl. 15 の立ち下がりエッジでモジュールをシャットダウン

• マニュアル操作によるモジュール制御

－ マニュアルトリガによる記録開始

－ コンフィギュレーションの選択

－ データアップロードの開始

• デジタル信号の測定

－ ステータス信号を他の測定信号とともに記録

－ イベントの記録

ピン番号 I/O 点数 タイプ 説明

1-4 4 出力 - TTL 互換

- INCA 用シグナルとして使用可能。

9 1 出力 - TTL 互換

- ES720.1 の動作ステートが出力されるので（High = 
ON、Low = スタンバイ）、 他の測定モジュールの電源
制御に利用可能

11 1 入力 - TTL 互換

- 外付けのリモート電源スイッチをグラウンドに接続
し、モジュールの電源ボタンと同じ機能を持たせる
ための入力

12 1 入力 - High レベル : 5V 以上 （ECU のイグニション端子 Tl. 
15 など）

13-16 4 入力 - TTL 互換

- INCA 用シグナル（ステータス、トリガ）を接続可能

- 最大サンプリングレートは 10Hz
19-24 6 出力 - 前面パネルの LED のステータス（ON/OFF）を出力
ES720.1 - ユーザーズガイド



ETAS 機能説明
デジタル出力

デジタル出力は以下のような用途に利用できます。

• システムステータス信号の出力

－ モジュール起動処理中

－ 記録中

• 接続されている測定モジュールのオン／オフ

－ ウェイクアップ機能をサポートしていないモジュール用

－ 複数マスタによるイーサネット競合の回避用

• 測定信号の出力

－ 測定信号の監視と範囲エラーの表示

－ ECU 状態の表示

4.6 VGA モニタインターフェース（“VGA” ポート）

VGA ポートは、ES720.1 モジュールに内蔵されたエンベデッド PC のグラフィック
ユニットのアナログ画像信号を VGA ポートを搭載したモニタに出力するための標準

VGA ポートです。ドライブレコーダの以下のステータス情報を VGA に接続された
モニタに表示できます。

• 開始処理中の情報

• 記録のステータス

• ディスク消費率、記憶装置使用率

• PC のシステムパフォーマンスとリソース使用率

• リモートインターフェース（I/O ポート）のステータス

• データ転送

4.7 無線 LAN インターフェース（“WLAN” ポート）

WLAN アンテナ接続用の WLAN ポートは ES720.1 の全製品タイプに設置されてい
ます。

ただしこのポートを使用できるのは、製品タイプ ES720.1-8W および ES720.1-16W
のモジュールだけです。これらのタイプの ES720.1 モジュールには WLAN モジュー
ルが内蔵されていて、WLAN ポートが使用可能です。

WLAN モジュールは安全にデータ通信を行うための WPA2 暗号をサポートしていま
す。
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4.8 動作ステート

ドライブレコーダ ES720.1 の動作ステートには、「OFF」、「低電力スタンバイ」、「高
速ブートスタンバイ」、「ON」があります。

4.8.1 動作ステート： OFF

ES720.1 に外部電源が供給されておらず、モジュール全体が完全に「電源オフ」状
態になっています。モジュールのエンベデッド PC はシャットダウンされ、すべての
インターフェースが非稼動状態になっています。ウェイクアップ機能（27 ページの

4.9 項を参照してください）も無効になっています。

4.8.2 動作ステート： スタンバイ

ES720.1 は外部電源に接続されていて、モジュールの動作ステートは以下の 2 つの
スタンバイ状態のうちのいずれかになっています。

• 低電力スタンバイ（“Low Power Standby”）

• 高速ブートスタンバイ（“Fast Boot Standby”）

どちらのスタンバイ状態を有効にするかは、ES720 コンフィギュレーションツール
（コンフィギュレーション設定用ソフトウェアツール）で選択できます。

モジュールはウェイクアップイベントを待っている状態です。このイベントが発生
すると、モジュールの動作ステートが上記のいずれかのスタンバイ状態から ON 状
態に変わり、自動的に測定を開始します。

動作ステート： 低電力スタンバイ（“Low Power Standby”）

「低電力スタンバイ」状態においては、ドライブレコーダのエンベデッド PC は休止
状態（“Hibernate”、“Suspend-To-Disk”）になっています。この時の ES720.1 の消
費電流は「高速ブートスタンバイ」状態よりも小さくなっています。

「低電力スタンバイ」ステートに移行する際には、その時点のシステムの状態や設定
データがハイバネーションファイルに保存されます。

このステートにおいてはウェイクアップ機能が有効になっており、所定のイベント
が発生することによって ES720.1 は別の動作ステートに移行します。

ES720 コンフィギュレーションツールでスタンバイモードとして「低電力スタンバ
イ」を選択すると、スタンバイ状態にあるドライブレコーダは、「高速ブートスタン
バイ」の場合よりも長い遅延の後に測定データの記録を開始できる状態になります。

動作ステート： 高速ブートスタンバイ（“Fast Boot Standby”）

「高速ブートスタンバイ」状態においては、ドライブレコーダのエンベデッド PC は
スタンバイ状態（“Standby Mode”、“Suspend-To-RAM”）になっています。この
時の ES720.1 の消費電流は「低電力スタンバイ」よりも大きくなっています。

このステートにおいてはウェイクアップ機能とスリープ機能が有効になっており、
所定のイベントが発生することによって ES720.1 は別の動作ステートに移行します。

ES720 コンフィギュレーションツールでスタンバイモードとして「高速ブートスタ
ンバイ」を選択すると、ドライブレコーダはスタンバイ状態から最小限の遅延の後
に測定データの記録を開始できる状態になります。

4.8.3 動作ステート： ON

「ON」状態においては、ドライブレコーダのエンベデッド PC のすべてのモジュール
とインターフェースが稼動しています。モジュールはいつでも測定データの記録を
開始できる状態になっています。
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4.9 動作ステートの遷移

4.9.1 状態図

ES720.1 モジュールの動作ステートの遷移は、図 4-2 のような遷移図に表すことが
できます。

図 4-2 ES720.1 の動作ステートの遷移（概略図）

図 4-2 内の遷移を示す線上に示された数字は、当該遷移が行われるためのイベント
を表します。各イベントは、電源オン、またはウェイクアップ機能とスリープ機能
が使用する所定のトリガ信号やタイマによって発生します（27 ページの 4.9.2 項を
参照してください）。

測定が完了すると、測定データは安全に保存されます。コンフィギュレーション設
定に応じて、ES720.1 モジュールは電源オンのままになるか、またはスタンバイ状
態（「高速ブートスタンバイ」または「低電力スタンバイ」）に遷移します。

4.9.2 イベントとタイマ

ES720.1 の動作ステートの遷移は「イベント」によりトリガされます。各イベント
の有効化／無効化はコンフィギュレーションソフトウェアで設定でき、遅延タイマ
を使用してイベントの発生を遅らせることもできます。

27 ページの図 4-2 に番号で示されている各イベントの内容は、以下のとおりです。

一般イベント

イベント 発生要因

図 4-2 内の番号 略称

1 PWR On 電源オン

11 PWR Off 電源オフ

Low Power Standby

On Fast Boot Standby

Off

7 , 8 , 9

2 , 3 , 4 , 5

6 , 7 , 8 , 9 10

111

2, 3 , 4 , 5

1111

（低電力

（高速ブート
スタンバイ）

スタンバイ）
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ウェイクアップイベント

シャットダウンイベント

イベントに使用されるタイマ

設定可能なタイマを用いて、ES720.1 の動作ステートの遷移をトリガするイベント
の発生を遅延させることができます。必要に応じて新しいハイバネーションファイ
ルが作成されます。

シャットダウン／スタンバイ 遅延タイマ : ES720 コンフィギュレーションツール
内で時間を定義できます。ES720.1 の動作ステートの遷移をトリガするためのすべ
てのイベントが、この時間だけ遅れて発生するようになります。ただしモジュール
の電源ボタンの押下と、INCA の実験に定義されたイベントについては、このタイマ
による遅延は発生しません。

高速ブートスタンバイから低電力スタンバイへの移行タイマ : ES720 コンフィギュ
レーションツール内で時間を定義できます。ES720.1 の動作ステートが「高速ブー
トスタンバイ」に遷移したときにタイマのカウントダウンが開始され、その状態の
ままタイマが満了すると「低電力スタンバイ」に遷移します。

4.9.3 電源ボタンの機能

ES720.1 モジュールの電源ボタンには、ES720.1 の動作ステートの遷移を制御する
ための「マスタ機能」が備わっています。 

イベント 発生要因

図 4-2 内の番号 略称

2 PBP モジュールの電源ボタンを短時間押下

3 On Pin 外付けリモート電源スイッチまたはデジタル入力
（I/O ポートの PSCI ピン）が Low から High に変化

4 On Time ウェイクアップ時刻（設定可能）の到来

5 On ETH ETH インターフェース（PC または測定モジュール）
上の通信トラフィックを検知

イベント 発生要因

図 4-2 内の番号 略称

6 PBP モジュールの電源ボタンを押下

PBPE モジュールの電源ボタンを 5 秒より長く押下
（緊急停止）

7 On Pin 外付けリモート電源スイッチまたはデジタル入力
（I/O ポートの PSCI ピン）が High から Low に変化

9 On Time シャットダウン時刻（設定可能）の到来

8 Auto 記録ジョブが終了し、後続のジョブがない

10 Timer 「高速ブートスタンバイ」から「低電力スタンバイ」
に移行するためのタイマの満了

注記

ES720.1 のファームウェアまたはコンフィギュレーションソフトウェアの更新中、
およびインストールの実行中は、電源ボタンや外付けリモート電源スイッチを絶
対に押さないでください。
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電源オン

前面パネルの電源ボタン、または外付けのリモート電源スイッチ（I/O ポートの 
RPBI ピンに接続、24 ページの 4.5 項項を参照してください）を短時間押下すると、

ES720.1 の電源がオンになります。

それと同時にウェイクアップ用のすべてのトリガイベントが 15 秒間抑止されます。

電源オフ

前面パネルの電源ボタン、または外付けのリモート電源スイッチ（I/O ポートの 
RPBI ピンに接続）を短時間押下すると、ES720.1 の電源が所定の処理実行後にオフ
になります。

それと同時にウェイクアップ用のすべてのトリガイベントが 15 秒間抑止されます。

電源オフ（緊急停止）

前面パネルの電源ボタン、または外付けのリモート電源スイッチ（I/O ポートの 
RPBI ピンで接続）が 5 秒以上押下されると、ES720.1 の電源がオフになります。

この処理は標準 PC の「ハードシャットダウン」に相当します。システムのプロセス
や測定／記録処理は即時に中断され、データは保存されずに不完全な状態となりま
す。

記録ジョブのキャンセル

ON の LED が点灯状態で信号音が 2 回続けて鳴った後、前面パネルの電源ボタンま
たは外付けのリモート電源スイッチ（I/O ポートの RPBI ピンで接続）を短時間押下
すると、予約されている記録処理がキャンセルされます。

4.9.4 モジュールの電源をオフにする

電源オフの処理

ES720.1 がどの動作ステートである場合も、通常の電源オフ（つまり緊急停止以外
の電源オフ）の処理は以下のシーケンスで実行されます。

1. 実行中の測定を終了します。

2. 測定データを記録し、記録完了を確認します。

3. ポート USB、ETH、WLAN のうち、使用中のポートのデータ転送完了を待ち
ます。

4. ES720.1 モジュールの電源を完全にオフにします。
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エラー処理

電源オフ処理中のデータ保存においてエラーが発生すると、ER の LED がエラーを知
らせ、電源オフの処理が続行されます。

その後 ES720.1 を再起動すると、ファイルのデータは復元メカニズムにより復元さ
れます。

4.10 データ転送

4.10.1 データ転送モード

マニュアルデータ転送（直接アクセス）

コンフィギュレーションデータや記録データの転送は、ES720 コンフィギュレー
ションツール（コンフィギュレーション設定用ソフトウェアツール）からマニュア
ル操作でトリガすることができます。データ転送は有線または無線で行えます（30
ページの 4.10.2 項を参照してください）。

自動データ転送（リモートアクセス）

ES720.1 のコンフィギュレーションにおいて「自動データ転送」が有効に設定され
ていると、記録データが PC またはサーバーにアップロードされる際、ES720.1 は、
そのモジュールに割り当てられた新しいコンフィギュレーションが PC またはサー
バー上に存在するかどうかを調べ、あった場合は、その新しいコンフィギュレー
ションを次回のデータ記録に使用します。データ転送は有線または無線で行えます

（30 ページの 4.10.2 項を参照してください）。リモートアクセス機能の併用により、
ドライブレコーダをユーザーの介入なしに自動操作できます。

4.10.2 データ転送用媒体

ドライブレコーダのタイプと内蔵されたモジュールに応じて、コンフィギュレー
ションデータや記録データを以下のような方法で転送できます。

• ケーブルを使用するデータ転送

－ LAN

各データ（コンフィギュレーションデータ、実験、記録データ）を ES720.1
と PC をつなぐケーブル経由でイーサネットにより転送します。

－ USB

各データ（コンフィギュレーションデータ、実験、記録データ）を ES720.1
と接続されている USB メモリとの間で交換します。

• 無線データ転送

－ WLAN

ES720.1 にオプションとして内蔵されている WLAN モジュールを社内のアク
セスポイントや公共のホットスポットに接続して、データを交換できます。

4.11 モジュールの温度監視

モジュール内部の温度は監視されています。筺体内の温度が臨界値を超えると「温
度過昇イベント」がトリガされ、モジュールは緊急停止します。この処理は電源が
切られた場合と同じメカニズムで動作します。

筺体内の温度が通常範囲内に戻った後は ES720.1 を再起動でき、中断された記録
ジョブのデータは復元されます。
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4.12 エンベデッド PC の監視

ES720.1 は、内蔵されたエンベデッド PC の以下のパラメータおよび状態を監視しま
す。

• 温度

• CPU 負荷

• RAM の空き容量

• バッテリ残量

• リアルタイムクロック（日付と時刻）

読み込まれた値は内部変数に書き込まれ、任意に記録ジョブに割り当てることがで
きます。
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5 モジュールの設置

本章には ES720.1 モジュールの設置作業に関する一般的な注意事項、設置方法、お
よび配線に関する注記が記載されています。

5.1 設置、および複数モジュールの連結

5.1.1 設置作業を行う際の一般的な注意事項

5.1.2 モジュールをキャリアラックに固定する

ES720.1 の筐体は頑丈な金属製で、プラスチックの滑り止めが付いています。また
取付用のねじ穴も用意されているので、キャリアラック等にねじで固定して自動車
内や実験室内に設置できます。

ES720.1 の筺体を固定する :

• モジュールの底面から滑り止めを取り外します。下図
のように、筐体底面とプラスチック脚との間にマイナ
スライバーを差し込み、てこのようにして持ち上げて
ください。

図 5-1 プラスチック脚を持ち上げる

滑り止めを外した部分にねじ穴が現れます。

モジュール固定用のねじ穴は、筐体底面の両側にあり
ます。

• M3 ねじを使用してモジュールをキャリアラックに固
定します。

注意！

モジュールを損傷または破壊する可能性があります。
このモジュールの組み立てと操作は、モジュール稼働時の環境条件（54
ページの第 8 章を参照してください）を確実に順守できる場所またはコ
ンポーネント内でのみ行うことができます。
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図 5-2 ねじ穴の断面 

5.1.3 複数のモジュールを連結して設置する 

ES720.1 には ETAS 標準のシステム筐体が使用されているため、ETAS コンパクトモ
ジュールファミリの各製品（ES59x、ES6xx、ES910）と連結して設置することが可
能です。付属の T 字ブラケットを使用して複数のモジュールを容易に連結でき、「モ
ジュールブロック」を構成することができます。

ES720.1 に ETAS コンパクトモジュールファミリ製品を連結する際は、そのモジュー
ルを ES720.1 の下側に取り付けてください。2 つのモジュールの接合面の 4 つのプ
ラスチック脚を取り除き、代わりに T 字ブラケットを取り付けて連結します。

2 つのモジュールを連結する :

• ES720.1 モジュールの底面の 4 つのプラスチック脚を
取り外します。

T ブラケットを差し込むための組み立て用スリットが
現れます。

• もう一方のモジュールの接合面の 4 つのプラスチック
脚を取り外します。

• T 字ブラケット頭部のロック用キャップを回して、
キャップの溝がブラケット頭部の縦軸と直角になるよ
うにし、2 個のブラケットを第 1 のモジュールの一方
の側面の組立用スリットに差し込みます。

• この 2 つの T 字ブラケットに第 2 のモジュールをはめ
込みます。

注意！

電子機器が損傷または破壊される可能性があります。
ねじ穴を加工しないでください。

注記

モジュールをキャリアに固定する際は、M3 シリンダねじを使用し、最大トルク

0.8 Nm で締め付けてください。
筺体のねじ穴へのねじ込み長さは 3mm を超えないようにしてください（33 ペー
ジの図 5-2 を参照してください）。

M3

0.25 x 45°

3.5 
m

in
4.5 m

ax
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図 5-3 2 つのモジュールを連結する

• T 字ブラケットのロック用キャップを 90° 回します。
これで 2 つのモジュールの連結部がロックされます。

• 残りの 2 つの T 字ブラケットをモジュールの反対側の
側面の組立用スリットに差し込み、同様に固定しま
す。

• さらに別のモジュールを積み重ねる場合は、同様の方
法で連結します。
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5.2 システム構成

5.2.1 システム構成の例

図 5-4 ES720.1 と各種 ETAS ハードウェアモジュールの接続例

図 5-4 内
のケーブル

機能 型式名

A 電源ケーブル CBP120、
CBP1205

B イーサネットケーブル（PC または ES51x 用） CBE100

C イーサネットケーブル（ES6xx 用） CBEP120

D イーサネットアダプタケーブル（100 MBit/s、ケーブル

E に接続）

CBAE330 

ES720

B

ES4xx

ES780

ES63x

ES51x

B

ES520 ES59x

ES600

ES1120 ES1135

ES910

A

F

ES581

USB

ES 610.1
AD1

AD2

AD3

AD4

AD5

AD6

AD7

AD8

ON
TX

ER

AD9
AD10

AD11
AD12

AD13
AD14

AD15
AD16

ES6xx

XETK

G

C D

E
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ES720.1 の各ポートへの配線は、どのような順序でも行えます。

別売ケーブルのオーダー情報については 68 ページの「ケーブルとアクセサリ」を参
照してください。 

5.2.2 “ETH” ポート

PC との接続

ES720.1 モジュール（ETH ポート）と PC の接続には付属の CBE100 ケーブルを使
用します。

ES720.1 と PC を接続する：

• ES720.1 の ETH ポートに PC インターフェースケーブ
ル CBE100 を接続します。

• このケーブルの RJ-45 コネクタを PC のイーサネット
ポートに接続します。

他の ETAS モジュールとの接続

ES720.1 モジュール（ETH ポート）と他のモジュールとを接続するには、接続する
各モジュールに適合するケーブルが必要です（35 ページの図 5-4 と表を参照してく
ださい）。

ES720.1 と他の ETAS モジュールを接続する：

• ES720.1 の ETH ポートに所定のインターフェース
ケーブルを接続します。

• ケーブルのもう一方のコネクタを、接続するモジュー
ルのイーサネットポートに接続します。

E イーサネットケーブル（1 GBit/s、ケーブル D に接続） CBE230

F 複合ケーブル（イーサネット／電源） CBEP420

G イーサネットケーブル（ES520、ES59x、ES600、

ES780、ES1120、ES1135 用）
CBE130、
CBE140

注記

ケーブルの接続を行う際は、ポートに電圧がかかっていないことを確認してくだ
さい。

注記

ケーブルを接続する際は、ケーブルの名前をよく確認してください。間違った
ケーブルを使用すると、ES720.1 およびその他のハードウェアモジュールの誤作
動や損傷を招く可能性があります。

図 5-4 内
のケーブル

機能 型式名
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5.2.3 “7-29V” ポート

ES720.1 モジュールに電源を接続するには、電源ケーブル CBP120 または CBP1205
を使用します。

ES720.1 に電源を接続する：

• 付属の電源ケーブル CBP120 または CBP1205 を

ES720.1 の 7-29V ポートに接続します。

• ケーブルの電源電圧ピンを所定の電源に接続します。

コネクタは色により識別できるようになっているの
で、色に注意して接続してください。

ES720.1 の電流消費と電源電圧範囲にも注意してくだ
さい。許容値は 61 ページの 8.5.2 項に記載されてい
ます。

危険！

危険な高電圧が印加されます！
電源ケーブルは、適切な車両バッテリまたは実験用の適切な専用電源に
のみ接続してください！商用電源ソケットには絶対に接続しないでくだ
さい！
誤って商用電源ソケットに接続してしまうのを防止するため、商用電源
ソケットの近辺では安全バナナプラグ付き電源ケーブル CBP1205 のご
使用をお勧めします。
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6 コンフィギュレーションとアプリケーション

本章では、コンフィギュレーションのコンセプト、IP アドレス管理、ソフトウェア
のライセンス管理、ES720 コンフィギュレーションツールについて概説します。

6.1 コンフィギュレーションのコンセプト

6.1.1 コンフィギュレーションファイルとコンフィギュレーションプログラム

ES720.1 モジュールのコンフィギュレーションを定義するには、1 つの「INCA エク
スポートファイル」と 2 つの「ES720.1 コンフィギュレーションファイル」が必要
です。実験とデータ記録を実行するにはこれら 3 つのファイルがすべてドライブレ
コーダに格納されている必要があります。

• INCA エクスポートファイル： 設定済みの INCA ワークスペース、接続される
モジュールが定義されたハードウェアコンフィギュレーション、実験の設定

（レコーダ設定やシグナル割り当てなど）、A2L ファイル、その他の情報が格
納されています。INCA エクスポートファイルは INCA 上で作成されます。

• 第 1 の ES720.1 コンフィギュレーションファイル： ES720.1 モジュール自体
のハードウェアコンフィギュレーション（モジュールのネットワーク設定、
静的設定、記録の設定、ファイル転送に関する情報に関するオプション設定）
が格納されています。ユーザーインターフェースでは「オプション設定」ま
たは「ハードウェアコンフィギュレーション」と呼ばれます。

• 第 2 の ES720.1 コンフィギュレーションファイル： 記録ジョブに関する情報
（ウェイクアップ機能などに関する設定、実験と記録のシーケンス定義）が格
納されています。ユーザーインターフェースでは「記録ジョブ」と呼ばれま
す。

上記 2 つの ES720.1 コンフィギュレーションファイルは、スタンドアロンプログラ
ム「ES720 コンフィギュレーションツール」（“ES720Configurator”）を使用して作
成します。

ES720 コンフィギュレーションツールはご購入時の ES720.1 モジュールにプリイン
ストールされていて、INCA PC にもインストールできます。

6.1.2 オンライン／オフラインでのコンフィギュレーション設定

スタンドアロンソフトウェアの ES720 コンフィギュレーションツールを使用して、

ES720.1 のコンフィギュレーションをオンラインまたはオフラインで設定できます。

オンラインでのコンフィギュレーション設定

オンラインでコンフィギュレーション設定を行うには、ES720.1 モジュールを PC に
接続します。ES720.1 コンフィギュレーションファイルは以下の 2 通りの方法で作
成できます。

• 接続されている PC に ES720 コンフィギュレーションツールがインストール
されている場合。ES720.1 コンフィギュレーションファイル（XML ファイ
ル）をその PC 上で作成し、ES720.1 に転送します。

• 接続されている PC に ES720 コンフィギュレーションツールがインストール
されていない場合。PC からリモートデスクトップ経由でドライブレコーダに
アクセスし、プリインストールされている ES720 コンフィギュレーション
ツールを使用して ES720.1 コンフィギュレーションファイルを作成し、その
まま ES720.1 に保存します。
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オフラインでのコンフィギュレーション設定

ES720.1 モジュールが PC に接続されていない場合は、オフラインでコンフィギュ
レーション設定を行うことができます。この場合、PC 上で ES720 コンフィギュ
レーションツールを使用して ES720.1 コンフィギュレーションファイル（XML ファ
イル）を作成して保存しておき、後で ES720.1 に転送します。

オフラインでのコンフィギュレーション設定には以下のようなデメリットがありま
す。

• モジュールのステータスが不明

• ES720.1 とのデータ交換などに関する設定が行えない

• 作成したコンフィギュレーションを PC に保存しておく必要がある

6.1.3 ステータス監視

ES720 コンフィギュレーションツールは、実行中の記録ジョブについて以下のス
テータス情報を表示します。

• プリセットされた設定の概要

• 実行中の記録ジョブについての最新ステータス

6.1.4 ユーザーのインタラクション

ES720 コンフィギュレーションツールでは、データのダウンロードや実験の開始な
どの処理をマニュアル操作で実行することもできます。

6.2 IP アドレスの管理

6.2.1 ES720.1 と INCA の設定

PC にインストールされている INCA が ES720.1 と通信するには、PC のイーサネッ
トインターフェースに固定の IP アドレスを割り当てる必要があります。通信は PC
と ES720.1 との間で直接、または ES720.1 のイーサネットインターフェースに接続
されているモジュール（ES600、ES592、ES593-D、ES595）経由で行われます。
イーサネットインターフェースに固定の IP アドレスを設定する方法については

『INCA 入門ガイド』、またはオペレーティングシステムのユーザーマニュアルを参照
してください。

6.2.2 ES720.1 のマシン設定

ES720 コンフィギュレーションツールのハードウェアコンフィギュレーションウィ
ンドウの “ マシン設定 ”（“Machine settings”）ページで、マシン名（ホスト名）、

IP アドレス、DHCP の有効化、日付と時刻、といった一般的なオプションを設定で
きます。

6.2.3 ES720.1 の IP アドレス

ES720.1 で使用される標準の ETAS ネットワークでは、192.168.40.xxx（xxx は 0-
255 の値）のクラス C の IP アドレスが使用されます。

他の ETAS モジュールとの互換性を維持するため、ES720.1 は IP アドレス

192.168.40.228（オプションの WLAN モジュールは 192.168.41.228）が設定され
た状態で出荷されます。
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6.2.4 同一ネットワーク内での複数の ES720.1 の使用

1 つのネットワーク内で複数の ES720.1 を使用する場合、ネットワーク識別子では
なくホストアドレス（xxx の部分）を調整する必要があります。INCA PC や ETAS 標
準イーサネットネットワーク内の他のイーサネットモジュールと通信するには、
ネットワーク識別子が 192.168.40.xxx である必要があります。

6.2.5 リモートデスクトップの使用

ドライブレコーダの Windows XP Embedded オペレーティングシステムにリモート
デスクトップでアクセスする際は、以下のアクセスデータを使用します。

アクセスが行える状態になれば、ES720.1 上の ES720 コンフィギュレーションツー
ルを起動することができます。

6.3 ソフトウェアのライセンス管理

ETAS ソフトウェア製品を使用するにはライセンスが必要です。本項では、ライセン
ス管理に関する以下の基本情報を説明します。

• ETAS ライセンスモデル（40 ページ）

• ライセンスの取得（40 ページ）

• ライセンスの登録（41 ページ）

ライセンスの適用範囲と法的な情報に関する詳細は、製品に添付されたドキュメン
トに記載されています。

6.3.1 ETAS ライセンスモデル

ES720.1 にインストールされる ETAS ソフトウェアライセンスには、「マシンネーム
ライセンス」と呼ばれるタイプのライセンスモデルが使用されています。このライ
センスモデルの特徴は以下のとおりです。

• このタイプのライセンスはユーザー自身が管理を行います。

• ライセンスは個々の ES720.1（一般的には ES720.1 に内蔵されたイーサネッ
トアダプタの MAC アドレス）に結び付けられるので、ES720.1 を使用する
場所やユーザーを限定しません。

• ES720.1 ドライブレコーダ 1 台ごとに 1 つのライセンスが必要です。

6.3.2 ライセンスの取得

マシンネームライセンスは ETAS ライセンスポータルから取得してください（URL は
エンタイトルメント証明書に記載されています）。

ライセンスポータルへのログイン方法には以下の 3 通りがあります。

• アクティベーション ID でログインする

ログインすると「アクティベーション」1 が表示され、これを管理することが
できます。アクティベーション ID は製品に添付されたライセンスドキュメン
トに記載されています。

アカウント DriveRecorder

パスワード etases720dr

1. 「アクティベーション」には、特定の製品とそのライセンス条件、ライセンス数など、
ライセンス発行に必要な情報が割り当てられています。各アクティベーションは、「ア
クティベーション ID」によって識別されます。
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• エンタイトルメント ID でログインする

エンタイトルメント1 に関連付けられたすべてのアクティベーションが表示
され、これらを管理することができます。この方法は、部署や会社単位で 1
つのエンタイトルメントを使用するような場合に便利です。

• E メールアドレスとパスワードでログインする

ユーザーアカウントに割り当てられたすべてのアクティベーションとエンタ
イトルメントが表示され、それらを管理することができます。この方法は、
ツール管理者の方が複数のエンタイトルメントを管理するような場合に便利
です。

ライセンスポータルの使用方法がわからない場合は ヘルプ というリンクをクリック
してヘルプドキュメントを開いてください。

必要な情報

マシンネームライセンスをアクティベート（= 有効化）するには、ライセンスを結
び付けるイーサネットアダプタの MAC アドレスが必要です。

ライセンスファイル

ライセンスポータルでライセンスが発行されると <name>.Licというライセンス
ファイルが生成されるので、このファイルを ETAS ライセンスマネージャで ES720.1
に登録（追加）します。

6.3.3 ライセンスの登録

ライセンスステータスの表示

ライセンスのインストール状態を調べる：

• ES720.1 のリモートデスクトップを使用して、

Windows の Start メニューから Programs → ETAS 
→ License Management → ETAS License 
Manager を選択します。

1. 「エンタイトルメント」は、ある製品について 1 つまたは複数のライセンスを保持する
ためのユーザー権限を表すものです。つまりエンタイトルメントはソフトウェアを使用
する権利の「口座」のようなもので、ここから必要に応じてライセンスを取り出すこと
ができます。

注記

イーサネットアダプタの MAC アドレスは、ES720.1 モジュール底面のラベルに
記載されています。
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• OK をクリックします。

ETAS ライセンスマネージャが開き、インストールさ
れている製品のライセンス情報が表示されます。各エ
ントリ行の先頭の列のシンボルと “Status” 列に表示
されるテキスト情報で、有効なライセンスがインス
トールされているかどうかがわかります。

ライセンスを追加する

新しいライセンスを ES720.1 に追加するには、以下の 3 通りの方法があります

• マニュアル操作でライセンスを追加する

• 自動処理でライセンスを追加する（USB 経由のファイル転送）

• 自動処理でライセンスを追加する（自動ファイル転送）

マニュアル操作でライセンスを追加する：

• ライセンスファイルを PC 上の以下のディレクトリに
コピーします。
D:¥EtasData¥ 
ES720_DriversAndTools<x.x>¥Licenses

<x.x>はツールのバージョン番号です。このパスは、
インストール時に変更できます。

• ES720 コンフィギュレーションツールを開きます。

• Tools → File Transfer (FTP)（日本語版ユーザーイン
ターフェースの場合：ツール → ファイル転送（FTP））
を選択します。

“File Transfer”（“ ファイル転送 ”）ダイアログボック
スが開きます。

• “Local PC”（“ ローカル PC”）フィールド内の

“[Licenses]” ノードを開きます。

• ライセンスファイル ES720.licが表示されます。

• このライセンスファイルを選択します。

• 2 つのフィールドの間にある “ → ” をクリックしま
す。

ローカルファイルディレクトリ（PC）にあるライセン
スファイルが ES720.1 のライセンスディレクトリに自
動的に移動されます。
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• Tools → File Persist current system cofiguration
（ツール → 現在のシステムコンフィギュレーションを
保存）を選択します。

ES720.1 が再起動します。

自動処理でライセンスを追加する（USB 経由のファイル転送）：

• USB メモリを PC に接続します。

• USB メモリのルートディレクトリに Licensesディ
レクトリ（RootFolder¥Licenses）を作成します。

• ライセンスファイルを Licensesディレクトリにコ
ピーします。

• ES720 コンフィギュレーションツールで、“Hardware 
Configuration”（“ ハードウェアコンフィギュレー
ション ”）ダイアログボックスを開きます。

• “File transfer settings”（“ ファイル転送 ”）ノードを
開きます。

• “USB settings”（“USB 設定 ”）を開きます。

• Enable automatic transfer（自動転送を有効にす
る）オプションをオンにします。

• USB メモリを ES720.1 に接続します。

• Tools → File Persist current system cofiguration
（ツール → 現在のシステムコンフィギュレーションを
保存）を選択します。

ES720.1 が再起動します。

自動処理でライセンスを追加する（自動ファイル転送）：

• PC のルートディレクトリに、Licensesディレクト
リ（RootFolder¥Licenses）を作成します。

• ライセンスファイルを Licensesディレクトリにコ
ピーします。

• ES720 コンフィギュレーションツールで、“Hardware 
Configuration”（“ ハードウェアコンフィギュレー
ション ”）ダイアログボックスを開きます。

• “File transfer settings”（“ ファイル転送 ”）ノードを
開きます。

• “File exchange configuration”（“ ファイル転送設定

”）ノードを開きます。

• “Automatic transfer settings”（“ 自動転送設定 ”）を
開きます。

• Enable automatic transfer（自動転送を有効にす
る）オプションをオンにします。

ライセンスファイルは次回の同期が行われる際に

ES720.1 に転送されます。

• Tools → File Persist current system cofiguration
（ツール → 現在のシステムコンフィギュレーションを
保存）を選択します。

ES720.1 が再起動します。
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6.4 ES720.1 を使用するための準備

ご購入いただいた ES720.1 モジュールを使用可能な状態にするには、最初に以下の

4 つのステップを実行する必要があります。

• ES720.1 を起動する（購入後、初回の起動）

• マニュアル操作でライセンスを追加する

• 日付、時刻、タイムゾーンを設定する

• ES720.1 を再起動する

ES720.1 を起動する：

• 前面パネルの電源ボタンを押して ES720.1 を起動しま
す。 

ES720.1 の起動処理が実行されますが、有効なライセ
ンスがインストールされていないため、エラーが発生
します。起動完了後、ER という LED が点灯します。

マニュアル操作でライセンスを追加する：

• ライセンスファイルを PC 上の以下のディレクトリに
コピーします。
D:¥EtasData¥ 
ES720_DriversAndTools<x.x>¥Licenses

<x.x>はツールのバージョン番号です。このパスは、
インストール時に変更できます。

• ES720 コンフィギュレーションツールを開きます。

• Tools → File Transfer (FTP)（日本語版ユーザーイン
ターフェースの場合：ツール → ファイル転送（FTP））
を選択します。

“File Transfer”（“ ファイル転送 ”）ダイアログボック
スが開きます。

• “Local PC”（“ ローカル PC”）フィールド内の

“[Licenses]” ノードを開きます。

• ライセンスファイル ES720.licが表示されます。

• このライセンスファイルを選択します。

• 2 つのフィールドの間にある “ → ” をクリックしま
す。

ローカルファイルディレクトリ（PC）にあるライセン
スファイルが ES720.1 のライセンスディレクトリに自
動的に移動されます。

日付、時刻、タイムゾーンを設定する：

• File → Open Options from Device（ファイル → オ
プション設定をデバイスから開く）を選択します。

“Hardware Configuration”（“ ハードウェアコンフィ
ギュレーション ”）ダイアログボックスが開きます。

• “Machine Settings”（“ マシン設定 ”）ノードを開き
ます。

• Exclude Settings from the configuration（これら
の設定をコンフィギュレーションから除外）オプショ
ンをオフにします。
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• “Date/Time settings”（“ 日時の設定 ”）グループ
フィールド内の Save Date/time to device（日時を
デバイスに保存）オプションをオンにします。

• 以下の各オプションを設定します。

－ Date（日付）

－ Time（時刻）

－ ES720 time zone（ES720 のタイムゾーン）

• Apply on ES720（ES720 に適用）をクリックしま
す。

• Close（閉じる）をクリックします。

ES720.1 を再起動する：

• Tools → File Persist current system cofiguration
（ツール → 現在のシステムコンフィギュレーションを
保存）を選択します。

ES720.1 が再起動します。再起動には約 5 分を要しま
す。

再起動が完了すると、ES720.1 は使用可能な状態にな
ります。

6.5 ES720.1 のコンフィギュレーション設定

ES720.1 ドライブレコーダのコンフィギュレーションの設定方法は、以下のドキュ
メントに説明されています。

• ES720 コンフィギュレーションツールのチュートリアル （英文のみ）

• ES720 コンフィギュレーションツールのオンラインヘルプ

ES720 コンフィギュレーションツールチュートリアルには、デバイスやレコーダ
（記録機能）、ネットワークを設定する方法が、テスト環境を用いてわかりやすく説
明されています。
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7 ドライブレコーダに関するトラブルシューティング

本章では、ES720.1 モジュール使用中に発生する可能性の高いトラブルや、個々の
ソフトウェアやハードウェアに依存しない一般的な問題が発生した場合の対処法に
ついて説明します。

7.1 エラー表示用 LED について

ES720.1 の前面パネルには ES720.1 モジュールの状態を示す LED（18 ページの 3.4
項を参照してください）が設置されていますので、トラブルシューティングにも役
立ちます。

7.2 ES720.1 固有のトラブル

以下の表に、ES720.1 の使用時に発生する可能性の高いトラブルとその解決法をご
紹介します。

さらに詳しい情報が必要な場合は、ETAS のサポート窓口までお問い合わせくださ
い。

トラブルの現象 診断 解決法の例

ES720 コンフィギュレー
ションツールから ES720.1
モジュールが見つからな
い。

ネットワークカードが正し
く設定されていますか？

INCA、ES720 コンフィ
ギュレーションツール、

HSP での操作：
使用されているネットワー
クカードが 60 ページの

8.4.1 項に記述されている
ように設定されているかを
確認してください。

ES720.1 モジュールが PC
に正しく接続されています
か？

接続ケーブルやコネクタが
破損していないかを確認し
てください。

ES720.1 による測定が開始
されない。

各測定モジュールからデー
タが送られていますか？

電源などのテスト環境条件
が要件を満たしていること
を確認してください。

各測定モジュールが正しく
接続されているかを確認し
てください。

データ転送時にデータが失
われる。

ETAS ハードウェアの接続
に WLAN が使用されてい
ますか？

ETAS ネットワークでは

WLAN は使用できません。

PC や各 ETAS ハードウェ
アの接続には ETAS の専用
ケーブルを使用してくださ
い。

ご使用のラップトップ PC
に適合したタイプのネット
ワークカードが使用されて
いますか？

8 ビットまたは 16 ビット
データバスの PCMCIA
カードは使用できません。

32 ビットデータバスの

PCMCIA カード、mini-
PCIExpressCard のいずれ
かを使用してください。
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7.3 一般的なトラブル

7.3.1 ハードウェアが接続できない

原因： パーソナルファイアウォールによる通信のブロック

パーソナルファイアウォールによって発生する可能性のある問題とその解決法は、

49 ページの「パーソナルファイアウォールによる通信のブロック」を参照してくだ
さい。

原因： リモートアクセス用クライアントソフトウェアによる通信のブロック

ETAS ハードウェアネットワーク外で使用されている PC には、リモートアクセス用
クライアントソフトウェアがインストールされているものがあり、それによって

ETAS ハードウェアへのアクセスが妨害される場合があります。それには以下のよう
な状況が考えられます。

• イーサネットメッセージをブロックするファイアウォールが使用されている
（47 ページの「原因： パーソナルファイアウォールによる通信のブロック」
を参照してください）

• トンネリングに使用されている VPN クライアントソフトウェアが誤ってメッ
セージをフィルタリングしてしまうことがあります。たとえば Cisco VPN ク
ライアントの V4.0.x より前のバージョンでは、特定の UDP ブロードキャス
トを不正にフィルタしてしまう、というケースがありました。

このケースに該当する場合は、VPN クライアントソフトウェアのバージョン
をアップデートしてください。

原因： ETAS ハードウェアのフリーズ

ETAS ハードウェアが何らかの理由でフリーズしてしまった可能性もあります。この
場合は、ハードウェアの電源を切ってから再投入してください。これによってハー
ドウェアは再初期化されるので、多くの場合、正常に戻ります。

原因： ネットワークアダプタへの IP アドレス割り当てが一時的に失われた

PC の接続を、DHCP が使用されている社内 LAN から ETAS ハードウェアに切り替え
る際、PC が ETAS ハードウェアを検知できるようになるまでに約 60 秒かかります。
これはオペレーティングシステムが DHCP プロトコルから ETAS ハードウェア用の

APIPA に切り替わる処理に要する時間です。

原因： ETAS ハードウェアが他の論理ネットワークに接続されている

1 つの ETAS ハードウェアに対して複数の PC からアクセスする場合、各 PC で使用
されるネットワークアダプタは、同じ論理ネットワークを使用するように設定して
おく必要があります。このように設定することが不可能である場合、他の PC を切り
替える前に ETAS ハードウェアの電源を切って再投入してください。

原因： ネットワークカード用のデバイスドライバが起動していない

ネットワークカード用のデバイスドライバが起動していない可能性があります。そ
の場合は、ネットワークカードを一旦無効にしてから再度有効にしてください。

ネットワークカードを無効にして、再度有効にする：

• ネットワークカードを無効にするには、Windows の 
スタート メニューから以下のように操作します。

－ Windows XP の場合： コントロールパネル → 
ネットワーク接続 を選択します。
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－ Windows Vista の場合： コントロールパネル → 
ネットワークとインターネット → ネットワーク
と共有センター → ネットワーク接続の管理 を選
択します。

• ETAS ネットワーク用に使用されているデバイスを右
クリックし、ショートカットメニューから 無効にす
る を選択します。

• 続いて同じショートカットメニューから 有効にする 
を選択し、カードを有効にします。

原因： ラップトップ PC の電源管理システムによってネットワークカードが無効に
なっている

ラップトップ PC の電源管理システムにより、ネットワークカードが無効になってい
る場合があります。この場合、ラップトップ PC の電源管理を無効にしてください。

ラップトップ PC の電源管理を無効にする：

• Windows の スタート メニュー以下のように操作しま
す。

－ Windows XP の場合： コントロールパネル → シ
ステム を選択します。

ハードウェア タブを選択し、デバイスマネー
ジャ ボタンをクリックします。

－ Windows Vista の場合： コントロールパネル → 
システムとメンテナンス → デバイスマネージャ 
を選択します。

• デバイスマネージャ ウィンドウで ネットワークアダ
プタ のツリーを展開します。

• 使用するネットワークアダプタを右クリックし、
ショートカットメニューから プロパティ を選択しま
す。

• 電源の管理 タブを選択し、コンピュータでこのデバイ
スの電源をオフできるようにする オプションをオフに
します。

• 詳細設定 タブを選択し、プロパティ に Autosense が
含まれている場合、これを無効にします。

• OK をクリックして設定を有効にします。

原因： ネットワークの自動切断

ネットワークカードのデータトラフィックが一定の時間途絶えると、ネットワーク
カードが自動的にイーサネット接続を切断する場合があります。これは、レジスト
リの autodisconnectキーを設定することによって避けることができます。

レジストリキー autodisconnectを設定する：

• レジストリエディタを開きます。

• HKEY_LOCAL_MACHINE/SYSTEM/
ControlSet001/Services/lanmanserver/
parameters というフォルダに含まれるレジストリ
キー autodisconnect の値を 0xffffffff に変
更します。
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7.3.2 パーソナルファイアウォールによる通信のブロック

原因： ファイアウォールによる ETAS ハードウェアのブロック

パーソナルファイアウォールは、ETAS のイーサネットハードウェアへのアクセスを
妨害する場合があります。そのような場合、ハードウェアの自動検索時に、コン
フィギュレーションが正しく設定されているのにもかかわらずイーサネットハード
ウェアがまったく検出されない、という状態が発生する可能性があります。

また、ファイアウォールが適切に設定されていないと、ETAS ソフトウェアにおける
特定の操作（例： ASCET で実験を開く、INCA や HSP でハードウェアを検索する、
など）を実行する際に不具合が発生する場合があります。

ファイアウォールによって ETAS ハードウェアとの通信がブロックされる場合は、

ETAS ソフトウェア使用中はファイアウォールソフトウェアを無効にするか、または
ファイアウォールの詳細設定を行って以下のアクセスを許可するようにしてくださ
い。

• UDP を経由する、デスティネーションアドレス 255.255.255.255 への出力
方向の IP ブロードキャスト（デスティネーションポート： 18001）

• UDP を経由する、ソース IP アドレス 0.0.0.0 からデスティネーション IP アド
レス 255.255.255.255 への入力方向の IP ブロードキャスト（デスティネー
ションポート： 18001）

• UDP を経由する、ETAS ネットワークへの直接 IP ブロードキャスト（デス
ティネーションポート： 18001）

• UDP を経由する、ETAS ネットワーク内のすてべの IP アドレスへの出力方向
の IP ユニキャスト（デスティネーションポート： 69、18001、18017、

49152 ～ 50175）

• UDP を経由する、ETAS ネットワーク内のすてべの IP アドレスからの入力方
向の IP ユニキャスト（ソースポート： 69、18001、18017、49152 ～

50175）

Windows オペレーティングシステムに組み込まれているパーソナルファイアウォー
ル以外に、サードパーティ（Symantec、McAfee、Blackice など）の各種パーソナ
ルファイアウォールも一般的によく使用されています。これらの各ファイアウォー
ルではそれぞれ対処方法も異なる場合がありますので、お使いのパーソナルファイ
アウォールの説明書をよくお読みください。

以下に一例として、Windows XP （SP2）においてハードウェアアクセスがブロック
された場合の Windows XP ファイアウォールの設定方法をご紹介します。

注記

実際のポート番号は、使用するハードウェアに応じて異なります。ポート番号に
ついての詳しい情報は、ハードウェアのドキュメントを参照してください。
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対策例： Windows XP ファイアウォールの設定（管理者権限を持つユーザーの場合）

PC の管理者権限を持っているユーザーの場合、ETAS ソフトウェアがファイア
ウォールによってブロックされると、以下のようなダイアログボックスが開きます。

製品のブロックを解除する：

• “Windows セキュリティの重要な警告 ” ダイアログ
ボックスで、ブロックを解除する をクリックします。

以降、該当する ETAS ソフトウェアはファイアウォー
ルによってブロックされなくなります。この設定は、
プログラムや PC の再起動後も維持されます。

上記の “Windows セキュリティの重要な警告 ” ダイアログボックスが開く前に、前
もって ETAS ソフトウェアのブロックを解除しておくこともできます。

ファイアウォールの設定を変更して製品のブロックを解除する：

• Windows のスタートメニューから 設定 → コント
ロールパネル を選択します。

注記

ファイアウォール設定を変更して PC をネットワークに接続する場合は、前もって
社内の IT セキュリティポリシーをご確認ください。またその際には IT 担当の方に
ご相談いただくことをお勧めします。
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ETAS ドライブレコーダに関するトラブルシューティング
• コントロールパネルから Windows ファイアウォール 
を選択します。

“Windows ファイアウォール ” ダイアログボックスが
開きます。

• “ 例外 ” タブを選択します。

このタブには、ファイアウォールによるブロックから
除外されているプログラムが一覧表示されます。

• プログラムの追加 または 編集 ボタンをクリックして、
新しいアイテム（プログラム）を追加するか、既存の
アイテムを編集します。
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ドライブレコーダに関するトラブルシューティング ETAS
• 以下のようにして、使用する ETAS ソフトウェアとそ
れに関連するサービスについて、正しく例外設定され
ていることを確認します。

－ 例外リストから該当するアイテムを選択して 編集 
をクリックし、“ プログラムの編集 ” ダイアログ
ボックスを開きます。

－ スコープの変更 をクリックし、“ スコープの変更

” ダイアログボックスを開きます。

－ ETAS ハードウェアへのアクセスが行えるように、

192.168.40.xxxという IP アドレスがブロッ
ク解除されていることを確認してください。

－ OK をクリックして “ スコープの変更 ” ダイアロ
グボックスを閉じ、さらに “ プログラムの編集 ”
ダイアログボックスも OK をクリックして閉じま
す。

• OK をクリックして “Windows ファイアウォール ”
ダイアログボックスを閉じます。

以降、該当する ETAS ソフトウェアはファイアウォー
ルによってブロックされなくなります。この設定は、
プログラムや PC の再起動後も維持されます。

対策例： Windows XP ファイアウォールの設定（管理者権限を持たないユーザーの
場合）

システム変更、書き込み、ローカルログオンなどの権限が制限されているユーザー
の場合は、以下のように操作してください。

ETAS ソフトウェアを使用するユーザーは、所定のディレクトリ（ETAS、

ETASData、ETAS の一時ディレクトリ）への “ 書き込み ” の権利が必要です。そ
れらの権利がない状態で ETAS ソフトウェアを起動すると、エラーメッセージが表示
され、その後データベースが開きますが、正しい操作は行えません。これは、ETAS
ソフトウェアの操作時にはデータベースファイルや *.iniファイルの書き換えが
必要なためです。

ETAS ソフトウェアは、必ず管理者権限のあるユーザーがインストールを行い、その
後、Windows XP ファイアウォールの例外リストにそのプログラムを正しく登録し
てください。これが行われていないと、以下の事柄が生じます。
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ETAS ドライブレコーダに関するトラブルシューティング
• ファイアウォールにより制限されているアクションを実行する
と、“Windows セキュリティの重要な警告 ” ダイアログボックスが開きま
す。

製品のブロックを解除する（管理者権限のないユーザーの場合）：

• “Windows セキュリティの重要な警告 ” ダイアログ
ボックスで、このプログラムについてはこのメッセー
ジを表示しない をオンにします。

• OK をクリックしてダイアログボックスを閉じます。

この後、管理者権限のあるユーザーが “Windows 
ファイアウォール ” ダイアログボックスの “ 例外 ”
タブで適切な設定を行い、ETAS ソフトウェアがハー
ドウェアアクセスを行えるようにする必要がありま
す。 
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8 テクニカルデータ

本章では、ES720.1 モジュールの各種データ（対応する規格、使用条件、メカニカ
ルデータ、運用時のシステム要件、電気的データ、ピン割り当て）をまとめます。

8.1 一般データ

8.1.1 製品ラベル

製品上のラベルには以下のシンボルまたは標記が使用されています。

注記

ドライブレコーダ ES720.1-8W および ES720.1-16W は、EU（欧州連合）、米国、
カナダ、インドでのみ認証されています。

シンボル 説明

製品使用時には必ず前もってユーザーズガイドをお読みくださ
い。

モジュール表面の高温による熱傷の危険性があります！
高気温における操作時には、モジュール表面に触れることは避け
てください。
車両内、または 70 °C の外気温においては、モジュールの表面温
度が 90 °C に達する場合があります。

電源ボタン

USB ポート

SN: 1234567 シリアル番号（7 桁）

Vx.y.z 製品のハードウェアバージョン

F 00K 123 456 製品の注文番号
（詳細は 74 ページの「オーダー情報」を参照してください）

動作電圧範囲（DC）

xy A 最大消費電流

WEEE 指令の適用表示マーク
（57 ページの 8.1.5 項を参照してください）

CE 適合ラベル（57 ページの 8.1.4 項を参照してください）

29V7
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ETAS テクニカルデータ
詳しくは、本章（第 8 章）の各項を参照してください。

8.1.2 対応規格

ドライブレコーダ ES720.1

本モジュールは以下の標準規格に準拠しています。

WLAN モジュール

本モジュールが準拠する規格とアンテナ仕様は以下のとおりです。

WLAN モジュールの場合、本書の指示に従うに当たり以下の特記事項が適用されま
す。

法規制遵守に関する注意事項

米国 - 連邦通信委員会（FCC: Federal Communications Commission）

FCC 無線周波数エネルギーの曝露および認定条件 : FCC ID: D962205 ANH

本装置は、FCC 規制第 15 部に定められたクラス B デジタル装置に関する制限に
従ってテストされ、これに準拠するものと認定されています。この制限は、本装置
を住宅に設置した際に有害な電波障害を起こさないよう合理的な対策を講じるため
に規定されたものです。本装置は、無線周波数エネルギーを生成して使用し、さら

中国の RoHS ラベル
（57 ページの項を参照してください）

無線通信ユニット用ラベル（ドライブレコーダ ES720.1-8W お
よび ES720.1-16W のみ）

FCC ID 米国 FCC（Federal Communications Commission）用識別番号 
（ドライブレコーダ ES720.1-8W および ES720.1-16W のみ）

IC カナダ産業省用識別番号 （ドライブレコーダ ES720.1-8W およ
び ES720.1-16W のみ）

規格 テスト項目

EN 61326-1 測定／制御／研究用電子機器に対する EMC 要件

EN 61000-6-2 工業環境におけるイミュニティ基準

EN 61000-6-3 エミッション規格（住宅，商業、軽工業環境）

IEC 60950-1:2014-08 情報通信機器（安全）

WLAN 規格 IEEE 802.11 b/g/n1)

WLAN セキュリティ IEEE 802.11i/D3.0 (WPA)、
IEEE 802.11i/D9.0 (WPA2)（デフォルト）

WLAN アンテナ WRR2400-RPSMA (Centurion) タイプのアンテナを 1 本のみ
使用可能

1): IEEE 802.11 n: 周波数域 2.4GHz でのみ接続が確立されます。

シンボル 説明
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にこれを放射する可能性があります。また、指示に従わないで設置し使用した場合、
無線通信に有害な電波障害を引き起こす可能性があります。ただしこれは所定の設
置状況で電波障害が発生しないことを保証するものではありません。本装置がラジ
オやテレビの受信に有害な電波障害を引き起こしていて、本装置の電源のオン／オ
フ操作によってそのことが確認できる場合、ユーザーが以下の方法により電波障害
の解決を試みることをお勧めします。

• 受信アンテナの方向または場所を変えてください。

• 本装置と受信機の距離を離してください。

• 受信機が接続されているものとは別の回路のコンセントに本装置を接続して
ください。

• 販売店またはラジオ／テレビの専門技術者に相談してください。

コンプライアンス責任者による明示的な承認がないまま本装置に変更または改変を
加えた場合、本装置を操作するユーザーの権限が無効になる可能性があります。

カナダ - カナダ産業省（IC: Industry Canada）

本装置はカナダ産業省の RSS 210 に準拠しています。

本装置は次の 2 つの条件を前提として使用してください。（1）本装置は有害な干渉
を発生させません。（2）本装置は、不適切な動作の原因となりうる干渉も含め、あ
らゆる干渉を受け入れます。

ライセンスを取得したサービスに対する無線電波障害を避けるため、本装置は屋内
の窓から離れた場所で最大限の保護下で使用してください。屋外に設置される装置

（つまり本装置の送信アンテナ）はライセンス管理の対象です。

欧州共同体 - CE 通達

CE マークは、以下の指令の基本要件に適合していることを示します。

• EN 300 328 

• EN 301 489-1

• EN 301 489-17

本装置は屋内使用向けに設計されています。

注意！

無線周波数エネルギーの放射にさらされます。

FCC RF 曝露コンプライアンス要件に準拠するためには、本装置のアン
テナは人体から 20cm 以上離して使用してください。本装置を他のアン
テナや発信機と同一場所に配置したり、一緒に使用したりしないでくださ
い。

注意！

無線周波数エネルギーの放射にさらされます。
本無線装置のアンテナは、カナダ保健省が一般住民を対象として定めて
いる無線電磁界曝露制限を超える電波を放射しない場所や向きに設置し
てください。この制限については、カナダ保健省のウェブサイト

（www.hc-sc.gc.ca/rpb）から取得できる安全コード 6 を参照してくださ
い。
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8.1.3 RoHS 適合について

ヨーロッパ連合

EU 指令 2002/95/EU は電気／電子デバイスに対する特定の危険物質の使用を制限す
る「RoHS 適合」を定義しています。

ETAS は、ETAS の製品がヨーロッパ連合内で適用されるこの指令に対応しているこ
とを確認しています。

中国

ETAS は、ETAS 製品が中国国内で製品またはそのパッケージに China RoHS マーク
を添付することを義務化する China RoHS（Management Methods for Controlling 
Pollution Caused by Electronic Information Products Regulation）に対応しているこ
とを確認しています。

8.1.4 CE マーキング

ETAS は、ETAS 製品が製品またはそのパッケージに CE マーキングを添付することを
義務化する欧州指令に対応していることを確認しています。CE 適合宣言書は、 ご要
望に応じてご提供させていただきます。

8.1.5 製品の回収とリサイクル

欧州連合（EU）では、廃電気製品の回収、処分およびリサイクルを行うシステムを

EU 全域にわたって確立するために、廃電気 / 電子機器指令（Waste Electrical and 
Electronic Equipment 指令、略して WEEE 指令）を制定しました。

これにより、機器は、資源を守り健康や環境に危害を与えない方法で確実にリサイ
クルされます。

図 8-1 WEEE 指令の適用表示マーク

製品の本体やパッケージに貼付される WEEE 指令の適用表示マーク（図 8-1 参照）
は、その製品を残留ゴミとして廃棄することが禁止されていることを示しています。

ユーザーは古い機器を個別に回収し、リサイクルのために WEEE 回収システムに返
却する義務があります。

すべての ETAS 装置が WEEE 指令の対象になっています。ただし、外部ケーブルや
バッテリは対象外です。

ETAS GmbH のリサイクルプログラムの詳細については、ETAS の担当窓口までお問
い合わせください（182 ページの第 16 章を参照してください）。

8.1.6 申告対象となる物質の使用

欧州連合

ETAS GmbH の製品（ハードウェアモジュール、ボード、ケーブルなど）には、EU
の REACH 規格 No. 1907/2006 で定義された「申告対象」に該当する化学物質を使
用しているものがあります。
詳しい情報は、ETAS ウェブサイトのダウンロードセンター（www.etas.com/
Reach）からご入手いただけます。この情報は継続的に更新されます。
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8.1.7 オープンソースソフトウェアの使用

本製品の一部にはオープンソースソフトウェア（OSS: Open Source Software）が使
用されています。このソフトウェアは出荷される製品にインストールされており、
ユーザーがこれを単独にインストールしたり更新したりする必要はありません。な
お本項のこの記述は、OSS のライセンス条項の条件を満たすためのものです。詳し
い情報の記載された文書（"OSS Attributions List"）は、ETAS ウェブサイト

（www.etas.com）から入手いただけます。

8.1.8 製品のメンテナンス

モジュール筐体の分解や改造は行わないでください。モジュール筐体に対する作業
をには所定の資格が必要です。故障などの際には必ず ETAS までご送付ください。

8.1.9 製品のクリーニング

モジュール筐体のクリーニングが必要な場合は、乾いた布で表面を拭いてください。
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8.2 環境条件

8.2.1 実験用設備での使用時

8.2.2 車両の客室またはトランク内での使用時

注記

ドライブレコーダ ES720.1-8W および ES720.1-16W の WLAN 機能は、屋内使用
向けに設計されています。

注記

VGA 出力使用時は、ES720.1 の全タイプの動作温度範囲が制限されます。

注記

本製品は、自動車産業用途向けに開発され、発売されたものであり、室内、また
は車両の客室内やトランクルームでの使用に適したものです。エンジンルームや
それに類似する環境内での使用には適していません。

温度範囲（稼働時） 1) -40 °C ～ +55 °C

-40 °F ～ +131 °F

温度範囲（稼働時） 2) -20 °C ～ +55 °C

-4 °F ～ +131 °F

温度範囲（保管時）
（梱包されていない状態）

-40 °C ～ +85 °C

-40 °F ～ +185 °F

設置高度 最大 5000 m / 16400 ft

汚染レベル 2

保護等級 IP20
1): ドライブレコーダ（VGA 出力を使用しない）
2): ドライブレコーダ（VGA 出力を使用する）

温度範囲（稼働時） 1) -40 °C ～ +70 °C

-40 °F ～ +158 °F

温度範囲（稼働時） 2) -20 °C ～ +70 °C

-4 °F ～ +158 °F

温度範囲（保管時）
（梱包されていない状態）

-40 °C ～ +85 °C

-40 °F ～ +185 °F

設置高度 最大 5000 m / 16400 ft

汚染レベル 2

保護等級 IP20
1): ドライブレコーダ（VGA 出力を使用しない）
2): ドライブレコーダ（VGA 出力を使用する）
59ES720.1 - ユーザーズガイド



60

テクニカルデータ ETAS
8.3 メカニカルデータ

8.4 システム要件

8.4.1 ハードウェア

電源

ES720.1 を稼動させるには、7V ～ 29V の直流電源が必要です。

イーサネットインターフェースを搭載した PC

ES720.1 を接続する PC には、空いているイーサネットインターフェース（RJ-45 コ
ネクタを装備、100 MBit/s、全二重）が 1 チャンネル必要です。PCMCIA ネット
ワークカードを使用する場合は、32 ビットデータバス（カードバス）仕様のものが
必要です。

ES720.1 を正常に初期化するための要件

パワーセーブモードを無効にする :

Windows デバイスマネージャの ネットワークアダプタ で、使用するネットワーク
アダプタをダブルクリックして選択し、電源の管理 タブで “ 電力の節約のために、
コンピュータでこのデバイスの電源をオフできるようにする ” というオプションを
オフにします。

ネットワークアダプタのパワーセーブ機能の名称は、アダプタの製造元によって異
なります。上記の名称以外に ”Link Down Power Saving” などがあります。

8.4.2 ソフトウェア

ES720.1 モジュールを設定し、さらにその制御とデータ収集について設定するには、
以下のソフトウェアバージョン、またはそれ以降のものが必要です。

• ES720 コンフィギュレーションツール V1.0.0

• 以下のいずれかの INCA ソフトウェア

－ INCA V7.0.0、および対応する INCA Add-On ES720

－ INCA V6.2.1、および対応する INCA Add-On ES720

寸法（H × W × D） 45 × 127 × 160 mm

1.75 × 5.0 × 6.3 in

重量 約 0.8 kg / 1.8 lbs

注記

PC ネットワークカードには、イーサネットインターフェース上でデータ転送が行
われていないときに自動的にパワーセーブモードに切り替わる機能が用意されて
いるものがありますが、この機能は必ず無効に設定しておいてください。

注記

ES720.1 を上記のものより古いバージョンで操作することはできません。
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8.5 電気的データ

8.5.1 ネットワーク

8.5.2 “7-29V” ポート（電源ソケット）

ピン割り当て

図 8-2 “7-29V” ポート

テクニカルデータ

ES720.1 の IP アドレス IP アドレス（デフォルト） 192.168.40.228

サブネットマスク（デフォルト） 255.255.255

リモートデスクトップ アカウント DriveRecorder

パスワード etases720dr

ピン 信号名 機能

1 UBATT+ 電源電圧（＋）

2 Ground グラウンド

動作電圧範囲 7 ～ 29V DC、±10％
（負荷遮断保護と逆極性保護あり）

電力消費（13.5V 時） 標準 100mW（低電力スタンバイ時）

標準 550mW（高速ブートスタンバイ時）

標準 5W（通常運転時）1)

標準 6W（通常運転時）2)

省電力機能 ウェイクアップ、スタンバイ

1): 測定実行、通常の CPU 負荷、WLAN オフ
2): 測定実行、通常の CPU 負荷、WLAN オン

2

1
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テクニカルデータ ETAS
8.5.3 “ETH” ポート（イーサネットソケット）

ピン割り当て  

図 8-3 “ETH” ポート

テクニカルデータ

ピン 信号名 機能

1 N.C. （予約済み）

2 N.C. （予約済み）

3 N.C. （予約済み）

4 RX+ データ受信（+）

5 TX- データ送信（-）

6 RX- データ受信（-）

7 N.C. （予約済み）

8 TX+ データ送信（+）

接続 10/100Base-T イーサネット

プロトコル TCP/IP

同期 ETAS 同期メカニズムに非対応

接続されるモジュールの電源 なし

1 8
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8.5.4 “USB” ポート（USB ソケット）

ピン割り当て

ES720.1 の前面パネルにある 4 つの USB ポートは、標準 USB ソケット（タイプ A）
です。

出力電流 

外部拡張メモリ  

拡張メモリ用に推奨される USB メモリ

ES720.1 のメモリ拡張機能は、以下の表に示される製品ファミリの USB メモリで動
作確認済みです。 

各 USB ポートの出力電流 500mA（最大）

4 つの USB ポートの出力電流合計 1.2A（最大）

注記

23 ページの「最大出力電流」および 23 ページの「過負荷と緊急停止」という項
の注記を参照してください。

ファイルシステム FAT32（必須）

パーティション数 1

注記

USB メモリにプリインストールされているソフトウェアやデータは、ES720.1 に
使用する前にアンインストールまたは削除しておく必要があります。

注意！

データ損失の恐れがあります！
データ転送中に USB メモリを ES720.1 から引き抜かないでください。

注記

USB メモリを使用する際は、メーカーから提供されているテクニカルデータと環
境条件を確認してください。これらの条件によって ES720.1 の動作範囲が制限さ
れる可能性があります。

メーカー 製品 製品番号

Hama FlashPen “Smarty” 8/16GB USB 100x 00094168, 
00094169

FlashPen “Fancy” 2/4/8/16GB USB Stick 40x 00055615, 
00055616, 
00055617, 
00090894
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8.5.5 “VGA” ポート（VGA モニタ用ソケット）

VGA ポートは、アナログ映像信号を VGA ポート搭載モニタに転送できる標準ポー
トです。

8.5.6 “WLAN” ポート（無線 LAN 用ソケット）

WLAN ポートと WLAN アンテナ

ES720.1 のすべての製品タイプには WLAN アンテナ取り付け用の WLAN ポートが
設置されています。 ただし実際にこのポートが機能するのは WLAN モジュール搭載
のタイプのみです。

ES720.1 の製品タイプ

WLAN モジュールは、ES720.1 の製品タイプのうち ES720.1-8W および ES720.1-
16W にのみ内蔵されています。このモジュールは WLAN ポートに接続されていま
す。

WLAN 関連規格

Kingston DataTraveler DT101 2/4/8/16GB, cyan DT101C/2GB, 
DT101C/4GB, 
DT101C/8GB, 
DT101C/16GB

DataTraveler DT101 2/4/8/16GB, gelb DT101Y/2GB, 
DT101Y/4GB, 
DT101Y/8GB, 
DT101Y/16GB

DataTraveler DT101 2/4/8/16GB, pink DT101N/2GB, 
DT101N/4GB, 
DT101N/8GB, 
DT101N/16GB

注記

55 ページの「法規制遵守に関する注意事項」を参照してください。

WLAN 規格 IEEE 802.11 b / g / n1)

WLAN セキュリティ IEEE 802.11i / D3.0 (WPA)、
IEEE 802.11i / D9.0 (WPA2)（デフォルト）

WLAN アンテナ WRR2400-RPSMA (Centurion) タイプのアンテナを 1 本のみ
使用可能

1): IEEE 802.11 n: 周波数域 2.4GHz でのみ接続が確立されます。

メーカー 製品 製品番号
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.5V@10mA、INCA シグナルを出力可能

.5V@10mA、INCA シグナルを出力可能

.5V@10mA、INCA シグナルを出力可能

.5V@10mA、INCA シグナルを出力可能

部の測定モジュールの動作電圧オン／オフ用に利用可能
＝ ES720.1 はスタンバイ状態）

ッチをグラウンドに接続し、モジュールの電源ボタンと

ニション端子 Tl. 15 など）
8.5.7 “I/O” ポート（デジタル I/O 用ソケット）

ピン割り当てとテクニカルデータ

図 8-4 “I/O” ポート

I/O ポートのすべての入力と出力は、±32V（DC）までは過電圧から保護されています。

ピン 信号名 タイプ ロジッ
ク電圧

最大電流
[mA]

機能

1 OUT_1 出力 5V 10 TTL 互換、最大 0.5V@0mA 、最小 2
2 OUT_2 出力 5V 10 TTL 互換、最大 0.5V@0mA 、最小 2
3 OUT_3 出力 5V 10 TTL 互換、最大 0.5V@0mA 、最小 2
4 OUT_4 出力 5V 10 TTL 互換、最大 0.5V@0mA 、最小 2
5 GND - - - グラウンド

6 GND - - - グラウンド

7 GND - - - グラウンド

8 GND - - - グラウンド

9 EN_PWR 出力 5V ステート TTL 互換、

ES720.1 の動作ステートに連動し、外
（High ＝ ES720.1 は電源オン、Low

11 /RPBI 入力 3.3V - TTL 互換、外付けのリモート電源スイ
同じ機能を持たせるための入力

12 PSCI 入力 - - High レベル : 5V 以上 （ECU のイグ

1

10

19

9

18

26
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z
記録ジョブの開始／終了トリガとして使用可能

z、INCA 測定シグナルとして使用可能

z、INCA 測定シグナルとして使用可能

z、INCA 測定シグナルとして使用可能

ラウンドに直接接続することが可能

グラウンドに直接接続することが可能

ラウンドに直接接続することが可能

グラウンドに直接接続することが可能

ラウンドに直接接続することが可能

グラウンドに直接接続することが可能
13 IN1 入力 - - TTL 互換、最大サンプリングレート 10H
INCA 測定シグナル、および ES720.1 の

14 IN2 入力 - - TTL 互換、最大サンプリングレート 10H
15 IN3 入力 - - TTL 互換、最大サンプリングレート 10H
16 IN4 入力 - - TTL 互換、最大サンプリングレート 10H
17 GND - - - グラウンド

18 GND - - - グラウンド

19 LED_ETH 出力 5V LED ETH の状態に連動、低電流 LED をグ

20 LED_WLAN 出力 5V LED WLAN の状態に連動、低電流 LED を

21 LED_PWR 出力 5V LED ON の状態に連動、低電流 LED をグ

22 LED_MEAS 出力 5V LED MEAS の状態に連動、低電流 LED を

23 LED_ERR 出力 5V LED ER の状態に連動、低電流 LED をグ

24 LED_MEM 出力 5V LED MEM の状態に連動、低電流 LED を

5 GND - - - グラウンド

6 GND - - - グラウンド

ピン 信号名 タイプ ロジッ
ク電圧

最大電流
[mA]

機能



ETAS テクニカルデータ
8.5.8 モジュールの起動時間

動作ステート 起動の所要時間（記録開始可能となるま
での時間）1)

ON なし（直ちに記録開始可能）

高速ブートスタンバイ（Suspend to RAM）約 10 秒

低電力スタンバイ（Suspend to Disk） 約 60 秒

OFF 約 60 秒

1): ES720.1 に接続されている各ハードウェアモジュールの起動時間や実験の規模な
どに応じて変化します。
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ケーブルとアクセサリ ETAS
9 ケーブルとアクセサリ

本章では ES720.1 モジュール用のケーブルとアクセサリの仕様をまとめます。

9.1 電源ケーブル

ES720.1 モジュールに使用できる電源ケーブルには以下の 2 タイプがあります。

• 電源ケーブル CBP120 － 標準バナナプラグ付き（従来の製品）

• 電源ケーブル CBP1205 － 安全バナナプラグ付き（新製品） 

注記

ES720.1 の各インターフェースには、必ず本書に記載されているケーブルを使用
してください。また、ケーブルの接続最大長を守ってください。

注記

ETAS では、ご要望に応じてカスタムケーブルを製作することができますので、詳
しくは ETAS の営業窓口までお問い合わせください。

危険！

危険な高電圧が印加されます！
電源ケーブルは、適切な車両バッテリまたは実験用の適切な専用電源に
のみ接続してください！商用電源ソケットには絶対に接続しないでくだ
さい！
誤って商用電源ソケットに接続してしまうのを防止するため、商用電源
ソケットの近辺では安全バナナプラグ付き電源ケーブル CBP1205 のご
使用をお勧めします。

注記

両タイプのケーブルの違いはプラグのタイプのみで、用途や許与電圧など、各種
テクニカルデータはどちらも同じです。
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9.1.1 CBP120 ケーブル

図 9-1 CBP120 ケーブル（標準バナナプラグを使用）

A 側 B 側

A 側 B 側

ピン 信号名 プラグ 信号名

1 UBATT 赤 UBATT

2 Ground 黒 Ground

製品名 型番 注文番号

Power Supply Cable, Lemo 1B FGJ  Banana (2fc-
2mc), 2 m 

CBP120-2 F 00K 102 584
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9.1.2 CBP1205 ケーブル

図 9-2 CBP1205 ケーブル（安全バナナプラグを使用）

A 側 B 側

A 側 B 側

ピン 信号名 プラグ 信号名

1 UBATT 赤 UBATT

2 Ground 黒 Ground

製品名 型番 注文番号

Power Supply Cable, Lemo 1B FGJ – Safety 
Banana (2fc-2mc), 2 m

CBP1205-2 F 00K 110 023

注記

安全バナナプラグ付き電源ケーブルは、安全ソケット付き電源への接続用にのみ
使用できます。
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9.2 イーサネットケーブル

9.2.1 CBE100 ケーブル

図 9-3 CBE100-x ケーブル

9.2.2 CBE130 ケーブル

図 9-4 CBE130-x ケーブル

9.2.3 CBE140 ケーブル

図 9-5 CBE140 ケーブル

A 側 B 側

製品名 型番 注文番号

Ethernet PC Connection Cable, Lemo 1B FGG - 
RJ45 (8mc-8mc), 3 m 

CBE100-3 F 00K 102 559

Ethernet PC Connection Cable, Lemo 1B FGG - 
RJ45 (8mc-8mc), 8 m 

CBE100-8 F 00K 102 571

A 側 B 側

製品名 型番 注文番号

Ethernet Connection and Power Supply Cable, 
Lemo 1B FGF  Lemo 1B FGD (8mc-8mc), 0m45

CBE130-0m45 F 00K 102 748

Ethernet Connection and Power Supply Cable, 
Lemo 1B FGF  Lemo 1B FGD (8mc-8mc), 3 m

CBE130-3 F 00K 102 587

A 側 B 側

製品名 型番 注文番号

Ethernet Connection and Power Supply Cable 
with Angular Connectors, Lemo 1B FMF  Lemo 
1B FMD (8mc-8mc), 0m45

CBE140-0m45 F 00K 104 153
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ケーブルとアクセサリ ETAS
9.2.4 CBEP420.1 ケーブル（電源ライン付き複合ケーブル）

図 9-6 CBEP420.1 ケーブル

9.2.5 CBEP425.1 ケーブル（電源ライン付き複合ケーブル）

図 9-7 CBEP425.1 ケーブル

A 側 B 側

製品名 型番 注文番号

Ethernet Connection and Power Supply Cable, 
Lemo 1B FGF  Lemo 1B FGL  Banana (8mc-
8fc+2mc), 3 m

CBEP420.1-3 F 00K 105 292

A 側 B 側

製品名 型番 注文番号

Ethernet Connection and Power Supply Cable, 
Lemo 1B FGF  Lemo 1B FGL  Banana (8mc-
8fc+2mc), 3 m

CBEP425.1-3 F 00K 105 972
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9.2.6 CBE230.1 ケーブル

図 9-8 CBE230.1-x ケーブル

9.2.7 CBAE330 アダプタケーブル

図 9-9 CBAE330 ケーブル

A 側 B 側

製品名 型番 注文番号

Ethernet Connection Cable 1 GBit/s, Lemo 1B 
FGE - Lemo 1B FGE (10mc- 10mc), 3 m

CBE230.1-3 F 00K 105 757

Ethernet Connection Cable 1 GBit/s, Lemo 1B 
FGE - Lemo 1B FGE (10mc- 10mc), 8 m

CBE230.1-8 F 00K 105 758

A 側 B 側

製品名 型番 注文番号

Ethernet Connection Adapter Cable 1 GBit/s to 
100 MBit/s, Lemo 1B PHE - Lemo 1B FGF (10fc-
8mc), 0m5 

CBAE330-0m5 F 00K 105 759
73ES720.1 - ユーザーズガイド



74

オーダー情報 ETAS
10 オーダー情報

本章は、各製品（本体、ケーブル、アクセサリなど）のオーダー情報をまとめたも
のです。

10.1 ES720.1 の製品バリエーション

ES720.1 ドライブレコーダ には、WLAN モジュールが搭載されたものとされていな
いものがあり、それぞれ内蔵メモリの容量（8GB ／ 16GB）と付属する電源ケーブ
ルのタイプ（CBP120 または CBP1205）に応じた製品バリエーションが用意されて
います。CBP1205（安全バナナプラグ付き電源ケーブル）については 68 ページの

9.1 項を参照してください。 

注記

誤って商用電源ソケットに接続してしまうのを防止するため、商用電源ソケット
の近辺では安全バナナプラグ付き電源ケーブルのご使用をお勧めします。

注記

安全バナナプラグ付き電源ケーブルは、安全ソケット付き電源への接続用にのみ
使用できます。
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10.2 ES720.1 製品パッケージ（WLAN モジュールなし）の内容

10.2.1 ES720.1-8（内部メモリ 8G バイト）

電源ケーブル CBP120 付き

電源ケーブル CBP1205 付き

製品名 型番 注文番号

ES720.1-8 Drive Recorder (8 GB internal memory) ES720.1-8 F 00K 107 105

パッケージ内容

 - ES720.1-8 ドライブレコーダ（内部メモリ 8GB）

 - ケーブル（CBP120-2、CBE100-3）

 - 筺体連結用 T 字ブラケット

 - CDROM（INCA_ADD-ON_ES720_CD）

 - 内容物一覧表 "Content of this Package"
 - 安全に関する注意事項（ES720_SAV）

 - 中国向け RoHS リーフレット "China-RoHS-leaflet_Compact_green_cn"

製品名 型番 注文番号

ES720.1-8 Drive Recorder (8 GB internal memory) ES720.1-8-S F 00K 110 462

パッケージ内容

 - ES720.1-8 ドライブレコーダ（内部メモリ 8GB）

 - ケーブル（CBP1205-2、CBE100-3）

 - 筺体連結用 T 字ブラケット

 - CDROM（INCA_ADD-ON_ES720_CD）

 - 内容物一覧表 "Content of this Package"
 - 安全に関する注意事項（ES720_SAV）

 - 中国向け RoHS リーフレット "China-RoHS-leaflet_Compact_green_cn"
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10.2.2 ES720.1-16（内部メモリ 16G バイト）

電源ケーブル CBP120 付き

電源ケーブル CBP1205 付き

製品名 型番 注文番号

ES720.1-16 Drive Recorder (16 GB internal memory) ES720.1-16 F 00K 107 107

パッケージ内容

 - ES720.1-16 ドライブレコーダ（内部メモリ 16GB）

 - ケーブル（CBP120-2、CBE100-3）

 - 筺体連結用 T 字ブラケット

 - CDROM（INCA_ADD-ON_ES720_CD）

 - 内容物一覧表 "Content of this Package"
 - 安全に関する注意事項（ES720_SAV）

 - 中国向け RoHS リーフレット "China-RoHS-leaflet_Compact_green_cn"

製品名 型番 注文番号

ES720.1-16 Drive Recorder (16 GB internal memory) ES720.1-16-S F 00K 110 463

パッケージ内容

 - ES720.1-16 ドライブレコーダ（内部メモリ 16GB）

 - ケーブル（CBP1205-2、CBE100-3）

 - 筺体連結用 T 字ブラケット

 - CDROM（INCA_ADD-ON_ES720_CD）

 - 内容物一覧表 "Content of this Package"
 - 安全に関する注意事項（ES720_SAV）

 - 中国向け RoHS リーフレット "China-RoHS-leaflet_Compact_green_cn"
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10.3 ES720.1 製品パッケージ（WLAN モジュール搭載）の内容 

10.3.1 ES720.1-8W（内部メモリ 8G バイト）

電源ケーブル CBP120 付き

電源ケーブル CBP1205 付き

注記

ドライブレコーダ ES720.1-8W および ES720.1-16W は、EU（欧州連合）、米国、
カナダ、インドでのみ認証されています。

製品名 型番 注文番号

ES720.1-8W Drive Recorder (WLAN, 8 GB 
internal memory)

ES720.1-8W F 00K 107 108

パッケージ内容

 - ES720.1-8W ドライブレコーダ（WLAN、内部メモリ 8GB）

 - ケーブル（CBP120-2、CBE100-3） 
 - 筺体連結用 T 字ブラケット

 - CDROM（INCA_ADD-ON_ES720_CD）

 - 内容物一覧表 "Content of this Package"
 - 安全に関する注意事項（ES720_SAV）

 - 中国向け RoHS リーフレット "China-RoHS-leaflet_Compact_green_cn"

製品名 型番 注文番号

ES720.1-8W Drive Recorder (WLAN, 8 GB 
internal memory)

ES720.1-8W-S F 00K 110 481

パッケージ内容

 - ES720.1-8W ドライブレコーダ（WLAN、内部メモリ 8GB）

 - ケーブル（CBP1205-2、CBE100-3）

 - 筺体連結用 T 字ブラケット

 - CDROM（INCA_ADD-ON_ES720_CD）

 - 内容物一覧表 "Content of this Package"
 - 安全に関する注意事項（ES720_SAV）

 - 中国向け RoHS リーフレット "China-RoHS-leaflet_Compact_green_cn"
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10.3.2 ES720.1-16W（内部メモリ 16G バイト）

電源ケーブル CBP120 付き

電源ケーブル CBP1205 付き

10.4 アクセサリ

10.4.1 サービス契約とマシンネームライセンス

製品名 型番 注文番号

ES720.1-16W Drive Recorder (WLAN, 16 GB 
internal memory)

ES720.1-16W F 00K 107 109

パッケージ内容

 - ES720.1-16W ドライブレコーダ（WLAN、内部メモリ 16GB）

 - ケーブル（CBP120-2、CBE100-3）

 - 筺体連結用 T 字ブラケット

 - CDROM（INCA_ADD-ON_ES720_CD）

 - 内容物一覧表 "Content of this Package"
 - 安全に関する注意事項（ES720_SAV）

 - 中国向け RoHS リーフレット "China-RoHS-leaflet_Compact_green_cn"

製品名 型番 注文番号

ES720.1-16W Drive Recorder (WLAN, 16 GB 
internal memory)

ES720.1-16W-S F 00K 110 482

パッケージ内容

 - ES720.1-16 ドライブレコーダ（WLAN、内部メモリ 16GB）

 - ケーブル（CBP1205-2、CBE100-3）

 - 筺体連結用 T 字ブラケット

 - CDROM（INCA_ADD-ON_ES720_CD）

 - 内容物一覧表 "Content of this Package"
 - 安全に関する注意事項（ES720_SAV）

 - 中国向け RoHS リーフレット "China-RoHS-leaflet_Compact_green_cn"

製品名 型番 注文番号

Service Contract for a machine-named 
license for ES720 Drive Recorder

ES720.1_SRV-ME52 F 00K 107 114

Machine-named license for ES720 ODX-
LINK add-on

ISW_ES720_ODX-LINK
_LIC-MP 

F 00K 107 147

Service contract for machine-named 
license for ES720 ODX-LINK add-on

ISW_ES720_ODX-LINK
_SRV-ME52 

F 00K 107 150

Machine named license for ES720 
Experimental Target Integration Package

ISW_ES720_EIP_LIC-MP F 00K 107 196
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10.4.2 ケーブル

電源ケーブル（“7-29V” ポート用）

イーサネットインターフェースケーブル（"ETH” ポート用）

10.4.3 筺体用アクセサリ

製品名 型番 注文番号

Power Supply Cable, Lemo 1B FGJ  Banana (2fc-
2mc), 2 m 

CBP120-2 F 00K 102 584

Power Supply Cable, Lemo 1B FGJ – Safety 
Banana (2fc-2mc), 2 m

CBP1205-2 F 00K 110 023

製品名 型番 注文番号

Ethernet PC Connection Cable, Lemo 1B FGG - 
RJ45 (8mc-8mc), 3 m 

CBE100-3 F 00K 102 559

Ethernet PC Connection Cable, Lemo 1B FGG - 
RJ45 (8mc-8mc), 8 m 

CBE100-8 F 00K 102 571

Ethernet Connection and Power Supply Cable, 
Lemo 1B FGF  Lemo 1B FGD (8mc-8mc), 0m45

CBE130-0m45 F 00K 102 748

Ethernet Connection and Power Supply Cable, 
Lemo 1B FGF  Lemo 1B FGD (8mc-8mc), 3 m

CBE130-3 F 00K 102 587

Ethernet Connection and Power Supply Cable 
with Angular Connectors, Lemo 1B FMF  Lemo 
1B FMD (8mc-8mc), 0m45

CBE140-0m45 F 00K 104 153

Ethernet Connection and Power Supply Cable, 
Lemo 1B FGF  Lemo 1B FGL  Banana (8mc-
8fc+2mc), 3 m

CBEP420.1-3 F 00K 105 292

Ethernet Connection and Power Supply Cable, 
Lemo 1B FGF  Lemo 1B FGL  Banana (8mc-
8fc+2mc), 3 m

CBEP425.1-3 F 00K 105 972

Ethernet Connection Cable 1 GBit/s, Lemo 1B 
FGE - Lemo 1B FGE (10mc- 10mc), 3 m

CBE230.1-3 F 00K 105 757

Ethernet Connection Cable 1 GBit/s, Lemo 1B 
FGE - Lemo 1B FGE (10mc- 10mc), 8 m

CBE230.1-8 F 00K 105 758

Ethernet Connection Adapter Cable 1 GBit/s to 
100 MBit/s, Lemo 1B PHE - Lemo 1B FGF (10fc-
8mc), 0m5 

CBAE330-0m5 F00K 105 709

製品名 型番 注文番号

T-Bracket for ES720 Housing
（筺体連結用 T 字ブラケット）

ES600_H_TB F 00K 001 925
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11 お問い合わせ先

ETAS 本社

ETAS GmbH

その他の支社

上記以外のお問い合わせ先につきましては、ETAS ウェブサイトをご覧ください。

Borsigstrasse 24 Phone: +49 711 3423-0

70469 Stuttgart Fax: +49 711 3423-2106

Germany WWW: http://www.etas.com/

各国支社 WWW: http:://www.etas.com/ja/contact.php

技術サポート WWW: http://www.etas.com/ja/hotlines.php

http://www.etas.com/
http://www.etas.com/ja/contact.php
http://www.etas.com/ja/hotlines.php
http://www.etas.com/
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